Copyright © 2013, Oracle and/or its affiliates. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software -- Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

This documentation may include references to materials, offerings, or products that were previously offered by Phase Forward Inc. Certain materials, offerings, services, or products may no longer be offered or provided. Oracle and its affiliates cannot be held responsible for any such references should they appear in the text provided.
# Contents

**About this guide** ix

- Overview of this guide .......................................................... x
- Audience ................................................................................. x
- Related information ................................................................. x
- Documentation ........................................................................ xi
- If you need assistance ............................................................. xiii

**Chapter 1  Introduction to the Central Designer Administrator and Central Designer applications** 1

- About Central Designer applications .................................... 2
- About the Central Designer Administrator application and users ........................................................................ 3
- About the Central Designer application and users .................. 4
- Getting help ............................................................................ 5
- Central Designer Administrator terms ..................................... 6
- Troubleshooting issues with Help ............................................ 7

**Chapter 2  Accessing the Central Designer Administrator application** 9

- Workspaces and views .......................................................... 10
- Users, rights, and roles .......................................................... 11
- Object-level locking ............................................................... 12
- Logging on and off ............................................................... 13
- Saving and resetting in the Central Designer Administrator application ......................................................... 14
- Undoing and redoing one or more actions ............................. 15

**Chapter 3  User administration** 17

- Checklist—Creating and configuring users and roles ................ 18
- Working with users ............................................................... 20
- Creating a user ....................................................................... 20
- Copying a user ....................................................................... 20
- Activating, deactivating, and terminating a user ..................... 20
- Filtering and searching the Users list ..................................... 21
- Refreshing the Users workspace ............................................ 21
- Changing the display name of a user ..................................... 21
- Changing the password of a user .......................................... 22
- Requiring users to change their passwords ............................ 22
- Changing the contact information of a user ............................ 22
- Viewing the rights granted to a user ...................................... 22
- Assigning a single user to one or more roles ......................... 23
- Removing a user assignment from one or more roles .......... 23
- Changing the view of the Skills tab ...................................... 24
- Specifying the language fluency skills of a user .................... 24
- Categorizing a user with keywords and categories ................. 25
- About the Users workspace .................................................. 26
- User Info tab ......................................................................... 26
- Personal Info tab .................................................................... 26
- User Roles tab ........................................................................ 26
- Skills tab ................................................................................ 28
- Categorization tab .................................................................. 29
- Statuses of users .................................................................... 29
Chapter 6  Catalog administration  79

Chapter 7  Server management administration  89
Chapter 8 Reference information

Keyboard shortcuts ................................................................. 96
Keyboard shortcuts for opening menus ................................ 96
Keyboard shortcuts for the Users workspace ..................... 96
Keyboard shortcuts for the Roles workspace ....................... 97
Keyboard shortcuts for the Custom Properties workspace .... 97
Keyboard shortcuts for the Catalog workspace .................... 98
Status toolbar—Option descriptions .................................... 99

Appendix A Rights descriptions

Roles workspace—Right descriptions .................................. 102
Application roles—Right descriptions ................................. 103
Application Administration .................................................. 103
Archive Administration ...................................................... 103
Catalog Administration ...................................................... 103
Coding Dictionaries Administration ................................. 104
Collaboration Administration ............................................. 104
Custom Properties Administration ..................................... 105
Language Library Administration ....................................... 105
Library Administration ....................................................... 105
Locales Administration ...................................................... 105
Reports Administration ..................................................... 106
Role Administration .......................................................... 106
Search ................................................................................. 106
Security Settings Administration ....................................... 107
Sponsors Administration ..................................................... 107
Study Administration ......................................................... 107
Units Administration .......................................................... 108
User Administration .......................................................... 108
Verbatim Types Administration ......................................... 108
Web Farm Administration .................................................. 109

Library roles—Right descriptions ....................................... 110
Library Administration ....................................................... 110
Library Collaboration ........................................................ 110
Library Design ................................................................. 110
Library Help ......................................................................... 111
Library Import Export ........................................................ 111
Library Import Export Translations .................................... 111
Library Jobs Browser ........................................................ 111
Library Logical Schemas .................................................... 112
Library Rule Design .......................................................... 112
Library Translation ............................................................ 112

Study roles—Right descriptions ......................................... 113
Study Administration ......................................................... 113
Study Annotated Studybook .............................................. 113
Study Collaboration .......................................................... 113
Study Deployment ............................................................. 114
Study Design ...................................................................... 114
Study Help .......................................................................... 115
Study Import Export ........................................................ 115
Study Import Export Translations ..................................... 115
Study Jobs Browser ........................................................... 115
Study Logical Schema ....................................................... 115
Study Rule Design ............................................................. 116
Study Translation .............................................................. 116
Appendix B  Adding units and conversion calculations  117

About units and conversion calculations ...................................................................................................................... 118
Unit XML definition ..................................................................................................................................................... 119
Conversion calculation XML definition .................................................................................................................... 120
Editing the units file .................................................................................................................................................. 121
Units defined in the units file ................................................................................................................................... 122
Conversion calculations defined in the units file ..................................................................................................... 123
Supported locales and their abbreviations ................................................................................................................ 124

Glossary  127

Index  137
About this guide

In this preface

Overview of this guide..............................................................................................................................x

Related information...................................................................................................................................xi

If you need assistance.............................................................................................................................xiii
Overview of this guide

The Administrator Guide for the Central Designer Administrator application provides step-by-step instructions for configuring administration information using the options in the user interface. The guide also provides:

- Checklists that summarize the main administration activities.
- Reference information about rights.
- A glossary of terms.

Audience

This guide is for users of the Central Designer Administrator application, including:

- User administrators
- System administrators
- Catalog administrators
Related information

Documentation

All documentation is available from the Oracle Software Delivery Cloud (https://edelivery.oracle.com) and the Download Center (https://extranet.phaseforward.com).

All documents may not be updated for every Central Designer release. Therefore, the version numbers for the documents in a release may differ. For a complete list of the documents in this Central Designer release, their release version numbers, and part numbers, see the Release Notes.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Notes</td>
<td>The Release Notes document provides detailed information about the requirements, enhancements, and fixed issues in the current release.</td>
</tr>
<tr>
<td>Known Issues</td>
<td>The Known Issues document provides detailed information about the known issues in this release, along with workarounds, if available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The most current list of known issues is available on the Extranet. To sign in to the Extranet, go to <a href="https://extranet.phaseforward.com">https://extranet.phaseforward.com</a>.</td>
</tr>
<tr>
<td>Installation Guide</td>
<td>The Installation Guide provides system requirements and instructions for installing and upgrading the Oracle® Health Sciences Central Designer software and the Oracle® Health Sciences Central Designer Administrator software.</td>
</tr>
<tr>
<td></td>
<td>This document is also available from the Documentation CD.</td>
</tr>
<tr>
<td>Administrator Guide</td>
<td>The Administrator Guide describes how to use the Oracle® Health Sciences Central Designer Administrator software to set up users, permissions, system configuration parameters, and catalog defaults.</td>
</tr>
<tr>
<td></td>
<td>This document is also available from the Oracle® Health Sciences Central Designer Administrator application user interface (HTML format) and the Documentation CD (PDF format).</td>
</tr>
<tr>
<td>User Guide</td>
<td>The User Guide introduces the study design environment in the Oracle® Health Sciences Central Designer application and describes how to work as a study design team in that environment, including how to:</td>
</tr>
<tr>
<td></td>
<td>• Work collaboratively.</td>
</tr>
<tr>
<td></td>
<td>• Maximize study design efficiency by reusing study objects.</td>
</tr>
<tr>
<td></td>
<td>• Manage collections of study objects.</td>
</tr>
<tr>
<td></td>
<td>This document is also available from the Oracle® Health Sciences Central Designer application user interface (HTML format) and the Documentation CD (PDF format).</td>
</tr>
<tr>
<td>InForm Design Guide</td>
<td>The InForm Design Guide describes how to design a study for deployment to the InForm application.</td>
</tr>
<tr>
<td></td>
<td>This document is also available from the Oracle® Health Sciences Central Designer application user interface (HTML format) and the Documentation CD (PDF format).</td>
</tr>
</tbody>
</table>
### About this guide

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rules Reference Guide</strong></td>
<td>The <em>Rules Reference Guide</em> is a reference to the tools that are available for creating rule expressions, including:</td>
</tr>
<tr>
<td></td>
<td>• Study object properties.</td>
</tr>
<tr>
<td></td>
<td>• Functions.</td>
</tr>
<tr>
<td></td>
<td>• Constants.</td>
</tr>
<tr>
<td></td>
<td>• Data mappings.</td>
</tr>
<tr>
<td></td>
<td>• Methods, operators, and literals.</td>
</tr>
<tr>
<td></td>
<td>This document is also available from the Oracle® Health Sciences Central Designer application user interface (HTML format) and the Documentation CD (PDF format).</td>
</tr>
<tr>
<td><strong>Secure Configuration Guide</strong></td>
<td>The <em>Secure Configuration Guide</em> provides an overview of the security features provided with the Oracle® Health Sciences Central Designer application, including details about the general principles of application security, and how to install, configure, and use the Central Designer application securely.</td>
</tr>
</tbody>
</table>
If you need assistance

Oracle customers have access to support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info, or if you are hearing impaired, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs.
CHAPTER 1
Introduction to the Central Designer Administrator and Central Designer applications

In this chapter

About Central Designer applications ................................................................. 2
About the Central Designer Administrator application and users .................. 3
About the Central Designer application and users .......................................... 4
Getting help ...................................................................................................... 5
Central Designer Administrator terms .......................................................... 6
Troubleshooting issues with Help ................................................................. 7
About Central Designer applications

The Central Designer application provides a collaborative design environment that supports multiple users and roles from any location.

There are two client applications:

- **Central Designer**—Used for collaborative study development.
- **Central Designer Administrator**—Used to set up users, permissions, system configuration parameters, and catalog defaults.

An administrator must set up administration information before you can perform some tasks.

The system configuration consists of the database server, the application server, and the application clients.
About the Central Designer Administrator application and users

In the Central Designer Administrator application, you create and manage:

- Users
- Roles
- Collaboration
- Supported locales
- Custom properties
- Categories
- Keywords
- Security settings

Some tasks in the Central Designer application cannot be performed until the administration information is set up correctly in the Central Designer Administrator application.

Other types of administration, including administering studies and libraries, are performed in the Central Designer application. For more information, see the User Guide.

Users might have the following roles within their organization:

**Note:** The following roles are examples. You can create roles as needed for your organization.

- **User administrator**—A user administrator manages users, roles, and rights.
- **System administrator**—A system administrator manages system configuration options, including supported locales, collaboration note types and task types, and custom properties.
- **Catalog administrator**—A catalog administrator manages the study object catalog and user catalog by creating keywords and categories.
About the Central Designer application and users

The Central Designer application provides a collaborative environment for developing clinical studies and addresses the need to significantly increase productivity in the study design process by:

- Providing one central environment for study design.
- Improving efficiency.
- Facilitating reuse.
- Supporting internal and external standards.

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clinical data manager</td>
<td>A user who is involved in the study design process.</td>
</tr>
<tr>
<td>Library administrator</td>
<td>A user with library administration privileges for one or more clinical areas.</td>
</tr>
<tr>
<td>Central Designer administrator</td>
<td>An IT representative who supports and maintains the application from a technology and infrastructure perspective.</td>
</tr>
<tr>
<td>Study design team</td>
<td>Users who implement a study. This team includes several roles such as form designer, rule designer, and study workflow designer.</td>
</tr>
<tr>
<td>Medical project manager</td>
<td>A user who works with the CRF designer to create an annotated study protocol, usually based on existing CRFs for the therapeutic area. This user is concerned with the overall set of study questions and logic, not the individual details of form design.</td>
</tr>
<tr>
<td>Statistician</td>
<td>A user who interacts with study designers with respect to data collection needs for analysis.</td>
</tr>
<tr>
<td>Translator</td>
<td>A user who is responsible for translating text in clinical studies, forms, items, and rule queries to a specified language.</td>
</tr>
</tbody>
</table>
Getting help

The Central Designer Administrator application provides the following ways to get help:

- **Administrator Guide**
  - Press F1, and then click the area of the application for which you want more information. A Help window appears with the relevant page displayed.
  - Select Help > Central Designer Administrator Help to open the Administrator Guide.

- **Hover Help**
  If you hold your mouse pointer over a button, tab, or icon without moving it, a tool-tip appears with a brief description of the item that you are pointing to.

If you need the version of the application, you can view it in the About Central Designer Administrator dialog box. The dialog box also contains copyright information.
## Central Designer Administrator terms

The Central Designer Administrator application uses the following terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>A person who works in the Central Designer or Central Designer Administrator application.</td>
</tr>
<tr>
<td>Role</td>
<td>A collection of rights. When a user is assigned to a role, the rights associated with the role are granted to the user.</td>
</tr>
<tr>
<td>Right</td>
<td>A predefined permission that controls access to a specific feature or activity in the Central Designer client or Central Designer Administrator client and that can be assigned to one or more roles.</td>
</tr>
<tr>
<td>Collaboration note type</td>
<td>A classification used to identify the type and purpose of a collaboration note.</td>
</tr>
<tr>
<td>Task type</td>
<td>A classification used to identify the type of the task and the way the task is used.</td>
</tr>
<tr>
<td>Supported locale</td>
<td>A supported language or language variation.</td>
</tr>
<tr>
<td>Custom property</td>
<td>A user-defined or default characteristic of a study object. The Central Designer Administrator application includes some predefined custom properties.</td>
</tr>
<tr>
<td>Keyword</td>
<td>An identifier that is associated with users and study objects to facilitate more powerful and efficient searches. A keyword can be system-generated or user-defined.</td>
</tr>
<tr>
<td>Category</td>
<td>A hierarchical grouping of keywords. You can create categories only from existing keywords. A category can be automatically generated or manually generated.</td>
</tr>
</tbody>
</table>
Troubleshooting issues with Help

If any of the tabs do not appear when you open the Help from the Help menu, add the name of the application server to the list of trusted sites.

1. In Internet Explorer, select **Tools > Internet Options**.
2. Select the **Security** tab.
3. Select **Trusted Sites**, and click **Sites**.
4. In **Add this Web site to the zone**, type the address that the client application uses to connect to the application server.
5. Click **OK** until you return to Internet Explorer.
CHAPTER 2

Accessing the Central Designer Administrator application

In this chapter

Workspaces and views ................................................................. 10
Users, rights, and roles ............................................................... 11
Object-level locking ................................................................. 12
Logging on and off ................................................................. 13
Saving and resetting in the Central Designer Administrator application ................................................................. 14
Undoing and redoing one or more actions ................................... 15
Workspaces and views

The Central Designer Administrator application window consists of:

- Toolbars and a menu bar.
- View pane. The view that you select (Users on page 26, Roles on page 41, System Config on page 47, or Catalog on page 86) determines the information that appears. Some tasks can be performed in the view pane.
- View menu buttons. When you click a view menu button, the associated workspace appears.
- Workspace. The appearance of the workspace depends on the view that is selected. Most tasks are performed in the workspace.
- Status icons. Icons indicate information about the connection between the client computer and the application server computer.
Users, rights, and roles

An administrator sets up users and roles in the Central Designer Administrator application. When an administrator creates a role, the administrator chooses:

- The scope of the role. A role can have a library, study, or application scope.
- The rights to associate with the role.

The scope of a role, rights assigned to the role, and teams determine whether users can perform certain activities and view different application areas.

- **Library scope**—Roles created with the library scope become library teams in the Central Designer application.
  
  To perform activities in a library, you must be assigned to:
  - A role with a library scope in the Central Designer Administrator application.
  - The corresponding library team in the Central Designer application.

- **Study scope**—Roles created with the study scope become study teams in the Central Designer application.
  
  To perform activities in a study, you must be assigned to:
  - A role with a study scope in the Central Designer Administrator application.
  - The corresponding study team in the Central Designer application.

- **Application scope**—Activities associated with the application scope are always available to all users, whether or not the users are assigned to teams. Roles created with the application scope do not become teams in the Central Designer application.
Object-level locking

The Central Designer Administrator application does not support object-level locking. If two or more users are modifying the same component in the Central Designer Administrator application, the changes of the person who saves last are stored in the database. Users can work in different areas of the application (for example, one can create roles and another can work in the catalog) without affecting each other.
Logging on and off

**To log on:**

1. Navigate to the following address:
   
   http://<server name>/CentralDesignerInstall
   
   where <server name> is the name of the application server computer.
   
2. Click the **Start Central Designer Administrator** link.

   A dialog box appears, indicating that the application is starting.

   The logon window appears.
   
3. Type your **User name** and **Password**.

   **Note:** When an account is created in the Central Designer Administrator application, the administrator can select an option that requires the user to change their password the next time they log on. You might be prompted to change your password.

4. Click **Log On**.

   The Central Designer Administrator application opens.

**To log off and log on as a different user:**

1. Select **File > Log On as a Different User**.

   You are logged off from the application, and the logon window appears.
   
2. Type the new **User name** and **Password**, and click **Log On**.

   The Central Designer Administrator application opens with the Users workspace selected.

**To log off:**

- Select **File > Exit**.

  If you have unsaved changes, you are prompted to save them.

  You are logged off, and the Central Designer Administrator application closes.
Saving and resetting in the Central Designer Administrator application

Some workspaces contain two buttons at the bottom-right corner:

- **Reset**—Clears unsaved data that has been entered in the workspace.
- **Save**—Saves the changes that you made in the workspace or tab.

**Note:** If you have made changes and select another button or tab, you are prompted to save changes, discard changes, or cancel.
Undoing and redoing one or more actions

You can undo and redo some actions:

- After you perform one or more actions that you can undo, a drop-down menu containing all actions that can be undone appears next to the Undo button. A similar drop-down menu is available for the Redo button.

- After you perform an action that cannot be undone or redone, the drop-down arrows on the Undo and Redo buttons are removed, and you cannot undo or redo any previous action.

**Note**: If you undo or redo any action except the last one you performed, the action you select and all actions that you performed after it are undone or redone.

To undo the last action you performed:
- On the general toolbar, click the **Undo** button.
  
  The last action that you performed is undone.

To undo a series of actions:
- On the general toolbar, click the drop-down arrow next to the **Undo** button, and select the action to undo.
  
  The action and all undoable actions that you performed after it are undone.

To redo an action:
- On the general toolbar, click the **Redo** button.
  
  The last action that you undid is redone.

To redo a series of actions:
- On the general toolbar, click the drop-down arrow next to the **Redo** button, and select the action to redo.
  
  The action and all redoable actions that you performed before it are redone.
In this chapter

Checklist—Creating and configuring users and roles ................................................................. 18
Working with users ........................................................................................................................ 20
About the Users workspace ........................................................................................................ 26
Option descriptions for the Users view and workspace .............................................................. 32
Checklist—Creating and configuring users and roles

Use the following checklist to create and configure users and roles, and to assign users to roles in the Central Designer Administrator application.

Perform the steps in the order in which they are presented. Depending on how your company uses the Central Designer application, you might not need to perform all steps.

<table>
<thead>
<tr>
<th>Workflow step</th>
<th>Where to get more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Log on to the Central Designer Administrator application.</td>
</tr>
<tr>
<td>2</td>
<td>Create a role. You must provide a name and description and choose a role scope (library, study, or application scope). Optionally, use a role that is available by default with the application.</td>
</tr>
<tr>
<td>3</td>
<td>Assign rights to a role. The available rights depend on the scope of the role. For example, library roles contain rights that control access to libraries.</td>
</tr>
<tr>
<td>4</td>
<td>Create a user. You must provide a user name, display name, and password.</td>
</tr>
<tr>
<td>5</td>
<td>Optionally, you can require the user to change the assigned password after the user logs on to the Central Designer application the first time.</td>
</tr>
<tr>
<td>6</td>
<td>Optionally, provide contact information for the user.</td>
</tr>
<tr>
<td>7</td>
<td>Select the languages in which the user is fluent. In the Central Designer application, translators see translation requests only for languages in which they have been specified as fluent. You must specify language fluency information before activating a user. Note: You select languages from a list of supported locales that have been specified in the Central Designer Administrator application. For more information, see Adding and removing a locale (on page 48).</td>
</tr>
<tr>
<td>Workflow step</td>
<td>Where to get more information</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>Associate a user with keywords or categories. Central Designer users can search for users using keywords and categories. <strong>Note</strong>: You can create additional keywords in the Catalog workspace. For more information, see <em>Checklist: Creating keywords and categories</em> (on page 80).</td>
</tr>
</tbody>
</table>
| 9            | Assign a user to a role:  
  - In the Users workspace, you can assign a single user to multiple roles.  
  - In the Roles workspace, you can assign multiple users to a single role.  
  **Assigning a single user to one or more roles** (on page 23).  
  or  
  **Assigning one or more users to a single role** (on page 40). |
| 10           | Activate the user. Activating the user allows the user to log on to the Central Designer application.  
  **Activating, deactivating, and terminating a user** (on page 20). |
Working with users

Creating a user

1. Click the **Users** button.
2. Right-click in the **Users** view, and select **Create User**, or press **Ctrl+N**.
   The Create User dialog box appears.
3. Fill in the fields in the dialog box, and click **OK**.
   The new user appears in the **Users** list, and the user properties appear in the workspace. The yellow status icon indicates that the user is inactive.

For more information, see **Create User and Copy User dialog boxes - Field descriptions** (on page 34).

Copying a user

A user created by copying an existing user has the same role assignments and language fluency skills as the original user, but the new user does not have the same personal information and has an inactive status. You must provide a new user name and password for the new user. After you copy a user, you can modify the information of the new user.

Consider copying a user if you need to create multiple users who will perform the same kinds of activities as an existing user.

1. Click the **Users** button.
2. Right-click in the **Users** view, and select **Copy User**, or press **Ctrl+C**.
   The Copy User dialog box appears.
3. Fill in the fields in the dialog box, and click **OK**.
   The new user appears in the **Users** list, and the user properties appear in the workspace. The yellow status icon indicates that the user is inactive.

For more information, see **Create User and Copy User dialog boxes - Field descriptions** (on page 34).

Activating, deactivating, and terminating a user

You cannot activate a locked user or a user whose status has been set to terminated.

1. Click the **Users** button.
2. In the **Users list**, right-click a user, and select one of the following options:
   
   - **Activate User** (or press **Ctrl+E**)—The status of the user changes to active, and the color of the status icon changes to green.
   
   - **Deactivate User** (or press **Ctrl+D**)—The status of the user changes to inactive, and the color of the status icon changes to yellow.
   
   - **Terminate User** (or press **Ctrl+T**)—The status of the user changes to terminated, and the color
of the status icon changes to red.

Filtering and searching the Users list

The Users list in the Central Designer Administrator application displays all Central Designer and Central Designer Administrator users and the status of each user.

To filter the Users list:
1. Click the **Users** button.
2. From the **Filter** drop-down list, select one of the following filters:
   - All
   - Active
   - Inactive
   - Locked
   - Terminated

To search the Users list by user name:
1. Click the **Users** button.
2. In the **Search** field, begin typing the name of the user you want to find.

   **Note:** The search field is case-sensitive.

   As you type, an incremental search of the Username field is performed, and the first user that matches the text that you type is selected.

Refreshing the Users workspace

Refreshing the Users workspace reloads information from the database.

- On the general toolbar, click **Refresh**.

Changing the display name of a user

The display name of a user appears in the title bar in the Central Designer application. The Display Name field is searched when you search for a user in the Users Browser in the Central Designer application.

1. Click the **Users** button.
2. In the **Users** list, select a user.
3. The Users workspace appears.
4. Select the **User Info** tab.
5. In the **Display Name** field, type the correct display name.
6. Click **Save**.
Chapter 3 User administration

Changing the password of a user

1. Click the Users button.
2. In the Users list, right-click a user, and select Change Password, or press Ctrl+P.
   The Change Password dialog box appears.
3. Fill in the fields in the dialog box, and click OK.

   **Note:** When you change a user password, the User must change password at next logon checkbox is automatically selected. If you do not want to require the user to change the password at the next logon, you can deselect the checkbox.

   For more information, see Change Password dialog box - Field descriptions (on page 35).

Requiring users to change their passwords

1. Click the Users button.
2. In the Users list, select a user.
3. Select the User Info tab.
4. Select User must change password at next logon, and click Save.
   The next time the user logs on to either the Central Designer or Central Designer Administrator application, the user is prompted to change the password.

Changing the contact information of a user

1. Click the Users button.
2. In the Users list, select a user.
3. Select the User Info tab.
4. Fill in or change the fields in the Personal Info tab as necessary, and click Save.
   For more information, see Personal Info tab - Field descriptions (on page 33).

Viewing the rights granted to a user

1. Click the Users button.
2. In the Users list, select the user whose rights you want to view.
   The Users workspace appears.
3. Select the User Roles tab.
4. Click View Rights (located below the Selected Roles list).
   The Granted Rights list appears to the right of the action lists, displaying all of the available rights for all role scopes. The rights that have been granted to the user are selected. As you assign the user to additional roles, the list is updated to show the rights that you grant.
Assigning a single user to one or more roles

In the Users workspace, you can assign a single user to one or more roles.

1. Click the Users button.
2. In the Users list, select the user that you want to assign to a role.
   
   The Users workspace appears.
3. Select the User Roles tab.
4. In the Available Roles action list, select the role to which you want to assign the user, and click the right arrow button.

   The user is assigned to the role, and the role is added to the Selected Roles action list.
5. Optionally, if you want to see a list of rights that are granted to the user, click View Rights (located below the Selected Roles list).

   The Granted Rights list appears to the right of the action lists, displaying all of the available rights for all role scopes. The rights that have been granted to the user are selected. As you assign the user to additional roles, the list is updated to show the rights that you grant.
6. Optionally, assign the user to additional roles as necessary.
7. Click Save.

Removing a user assignment from one or more roles

1. Click the Users button.
2. In the Users list, select the user whose role assignment you want to remove.

   The Users workspace appears.
3. Select the User Roles tab.
4. In the Selected Roles action list, select one or more roles whose assignments you want to remove and click the left arrow button.

   The Available Roles action list and the role assignments for the user are updated.
5. Click Save.
Changing the view of the Skills tab

The Skills tab in the Users workspace has two views, Categorized and Alphabetic.

<table>
<thead>
<tr>
<th>View</th>
<th>Description and example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Categorized view</td>
<td>Skills are grouped under the name of the skill type.</td>
</tr>
<tr>
<td></td>
<td>For example, the Translation Services category contains the Language Fluencies skill.</td>
</tr>
<tr>
<td>Alphabetic view</td>
<td>Skills are in an alphabetical list without skill type information.</td>
</tr>
<tr>
<td></td>
<td>For example, only Language Fluencies, not Translation Services, is included in the list.</td>
</tr>
</tbody>
</table>

- On the Skills tab toolbar, click either the Categorized button or the Alphabetic button.

Specifying the language fluency skills of a user

Language fluency information is used to determine the ability of a user to translate information into another language. You must specify locale information before activating a user.

You must specify at least one language fluency skill for each user, even for users who will not be translating. The skill set of a user must include all locales in which the user will develop study metadata, including the locale that is chosen as the default locale for a study, or, if a default locale is not chosen, the regional setting for the computer. Otherwise, the user does not have access to all functionality for the locale.

You cannot perform certain tasks in the Central Designer application until you have a language fluency skill in your own language.

1. Click the Users button.
2. In the Users list, select the user whose skills you want to change.
   The Users workspace appears.
3. Select the Skills tab.
4. Click the ellipsis button at the end of the LanguageFluencies field.
   The Add Locale dialog box appears.
5. Select the locales in which the user is fluent, and click OK.

   **Note:** You select languages from a list of supported locales that have been specified in the Central Designer Administrator application. For more information, see Adding and removing a locale (on page 48).

   The locales are added to the LanguageFluencies field.
6. Click Save.

For more information, see Skills tab - Field descriptions (on page 34).
Categorizing a user with keywords and categories

You can categorize a user with keywords and categories to facilitate more efficient user searches in the Central Designer application. You can create keywords and set up categories in the Catalog workspace.

To categorize a user with one or more keywords or categories:

1. Click the **Users** button.
2. In the **Users** list, select a user.
   
   The Users workspace appears.
3. Select the **Categorization** tab.
4. Catalog the user with one or more keywords or categories:
   
   - In the **Associate with keywords** area, select one or more keywords to use to categorize the user.
   
   - In the **Associate with categories** area, select one or more categories to use to categorize the user.
5. Click **Save**.

For more information, see **Categorization tab - List descriptions** (on page 34).
About the Users workspace

In the Users workspace, you perform user administration, which consists of:

- Creating new users and changing user information, including contact information, language fluency skills, and associated keywords and categories.
- Activating, deactivating, and terminating users.
- Assigning a user to one or more roles.
- Viewing, sorting, and filtering the list of Central Designer and Central Designer Administrator users.

For more information, see Users view - Option descriptions (on page 32).

User Info tab

In the User Info tab of the Users workspace, you can manage user passwords and display names.

To open the User Info tab:

1. Click the Users button.
2. Select a user.

The Users workspace appears, with the User Info tab selected by default.

For more information, see User Info tab - Field descriptions (on page 32).

Personal Info tab

In the Personal Info tab of the Users workspace, you can change the contact information of a user.

To open the Personal Info tab:

1. Click the Users button.
2. Select a user.

The Users workspace appears.
3. Select the Personal Info tab.

For more information, see Personal Info tab - Field descriptions (on page 33).

User Roles tab

In the User Roles tab of the Users workspace, you:

- View the rights granted to a user (on page 22).
- Assign a single user to one or more roles (on page 23).
- Remove user assignment from one or more roles (on page 23).
To open the User Roles tab:

1. Click the **Users** button.
2. Select a user.
   
   The Users workspace appears.
3. Select the **User Roles** tab.

**Illustration of the User Roles tab**

1. Available roles that can be assigned to the user selected in the Users list.
2. Select a role, and click a button to move it to the other list.
3. Roles that are assigned to the selected user.
4. Click View Rights to see the rights that are assigned to the selected role.
5. View rights that are assigned to the selected role.

For more information, see **User Roles tab - List descriptions** (on page 34).
Skills tab

In the Skills tab of the Users workspace, you specify user language fluency skills. Language fluency information is used to determine the ability of a user to translate information into another language. For example, some areas of the Central Designer application that require translation skills include:

- Study event short title.
- Form short title.
- Item Question and Short Question.
- Codelist item Label.
- Query text.
- Email text.
- Layout text.

You must specify at least one language fluency skill for each user, even for users who will not be translating. The skill set of a user must include all locales in which the user will develop study metadata, including the locale that is chosen as the default locale for a study, or, if a default locale is not chosen, the regional setting for the computer. Otherwise, the user does not have access to all functionality for the locale.

You cannot perform certain tasks in the Central Designer application until you have a language fluency skill in your own language.

To open the Skills tab:

1. Click the Users button.
2. Select a user.
   
   The Users workspace appears.
3. Select the Skills tab.

For more information, see Skills tab - Field Descriptions (on page 34).
Categorization tab

In the Categorization tab of the Users workspace, you associate a user with keywords and categories.

A keyword is an identifier that is associated with users and study objects to facilitate more powerful and efficient searches. A keyword can be system-generated or user-defined.

- System keywords are keywords that are installed by default with the Central Designer application or that an administrator creates in the Central Designer Administrator application.
- User keywords are keywords that a Central Designer user creates.

A category is a hierarchical grouping of keywords. You can create categories only from existing keywords. A category can be automatically generated or manually generated.

- Automatically generated categories are categories that automatically catalog study objects by auditing information (for example, the study object type, original author, creation date, and library in which the study object was created).
- Manually generated categories are categories that you create by dragging keywords to the Categories tree.

To open the Categorization tab:

1. Click the Users button.
2. Select a user.
3. Select the Categorization tab.

For more information, see Categorization tab - List descriptions (on page 34).

Statuses of users

Every Central Designer and Central Designer Administrator user is listed in the Users list (located in the Users view, to the left of the Users workspace). User status is represented by an icon.

<table>
<thead>
<tr>
<th>User status</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active users can log on to and use the Central Designer and Central Designer Administrator applications. You can deactivate or terminate an active user.</td>
<td>Green circle</td>
</tr>
<tr>
<td>Inactive</td>
<td>Inactive users cannot log on to either the Central Designer or Central Designer Administrator application. You can activate or terminate an inactive user.</td>
<td>Yellow circle</td>
</tr>
<tr>
<td>Terminated</td>
<td>Terminated users cannot log on to either the Central Designer or Central Designer Administrator application. A terminated user can never be activated or deactivated. If you terminate a user account, you can never use the account again. If you need to use the a terminated account, copy and paste the terminated account, and give the account a different name.</td>
<td>Red circle</td>
</tr>
</tbody>
</table>
### User administration

<table>
<thead>
<tr>
<th>User status</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>Locked users cannot log on to either the Central Designer or Central Designer Administrator application.</td>
<td>Lock</td>
</tr>
<tr>
<td></td>
<td>A locked user account or system user account is unlocked after the amount of time configured in the System lockout timeout or User lockout timeout settings. You can activate or deactivate a locked user account.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Users can log on only when they have the required rights that allow them to log on.

### About assigning users to roles

You can assign users to roles in both the Users and Roles workspaces. When you assign a user to a role, you authorize the user to assume the role in the studies or libraries where the user is a member of the corresponding team.

- A user assigned to a study role is granted the rights associated with the role only in studies where the user is also a member of the study team. For example, if a user is assigned to the Rule Creation study role in the Central Designer Administrator application, the user must also be a member of the Rule Creation study team for a study to create rules in the study.

- A user assigned to a library role is granted the rights associated with the role only in libraries where that user is also a member of the library team. For example, if a user is assigned to the Librarian library role in the Central Designer Administrator application, the user must be a member of the Librarian library team for a library (in the Central Designer application) to work in the library.

**Note:** You assign users to roles in the Central Designer Administrator application and to study and library teams in the Central Designer application.
You can assign a single user to multiple roles, and assign multiple users to a single role, as shown in the following illustration.

1—In the Users workspace, you can assign a single user to multiple roles.

2—In the Roles workspace, you can assign multiple users to a single role.

To grant rights to a user, you must first assign rights to a role, and then assign the user to that role.

**Default users**

**Archiveimporter user**

The archiveimporter user is created during installation. When study objects in an archive file refer to a user that does not exist in the target database, archiveimporter is inserted for the user's name in the Central Designer application. For example, if the user JohnSmith modified a study object in the archive but does not exist in the database, the History Viewer lists archiveimporter in place of JohnSmith after the archive is imported.

By default, the archiveimporter user has no rights. The password for this user is the same password as the one you select for the system user during the Central Designer installation.

**Note:** Oracle recommends that you do not terminate this user.

**System user**

After your initial installation, log on using the system user account, the initial administrator account, and create user accounts. After you have added users, you can terminate or keep the system user account.

- If you keep it, Oracle recommends associating it with a person in your organization for auditing purposes.
- If you terminate it, first create another user account with the **Perform all activities in all studies and libraries ("super-user")** right, which is available for application scope roles. At least one user should always have this right assigned.
Option descriptions for the Users view and workspace

Users view—Option descriptions

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Options are:</td>
</tr>
<tr>
<td></td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>• Active</td>
</tr>
<tr>
<td></td>
<td>• Inactive</td>
</tr>
<tr>
<td></td>
<td>• Terminated</td>
</tr>
<tr>
<td></td>
<td>• Locked</td>
</tr>
</tbody>
</table>

For more information about how to use the user filter, see *Filtering and searching the Users list* (on page 21).

| Search    | Search for a user by Username. As you type, an incremental search of the Username field is performed, and the first user that matches the text that you type is selected. For more information about how to search the Users list, see *Filtering and searching the Users list* (on page 21). |

| User Name | Name that is entered in the User Name field when a user is created. The User Name is used to log on to the Central Designer or Central Designer Administrator application. This field is searched when you search for a user in the Central Designer Administrator application. |

| Display Name | Name that is entered in the Display Name field when a user is created. The Display Name appears in the title bar in the Central Designer application. The Display Name field is searched when you search for a user in the Users Browser in the Central Designer application. |

User Info tab—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>User name for logging on to the Central Designer or Central Designer Administrator application. <strong>Note:</strong> You cannot modify a user name after the user has been created.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Name that appears in the title bar in the Central Designer application. The Display Name field is searched when you search for a user in the Users Browser in the Central Designer application.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Options are:</td>
</tr>
<tr>
<td></td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>• Active</td>
</tr>
<tr>
<td></td>
<td>• Inactive</td>
</tr>
<tr>
<td></td>
<td>• Terminated</td>
</tr>
<tr>
<td></td>
<td>• Locked</td>
</tr>
</tbody>
</table>

**Note:** You can modify the status of a user in the Users list only.

**User must change password at next logon**

- **Selected**—User must create a new password the next time they log on to the Central Designer or Central Designer Administrator application.
- **Not selected**—User is not required to change the password that you created.

---

## Personal Info tab—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>User title, such as Mrs., Ms., or Mr.</td>
<td>Alt+T</td>
</tr>
<tr>
<td>Position</td>
<td>User job title.</td>
<td>Alt+N</td>
</tr>
<tr>
<td>First Name</td>
<td>User full name.</td>
<td>Alt+S</td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
<td>Alt+L</td>
</tr>
<tr>
<td>Email</td>
<td>User email address.</td>
<td>Alt+M</td>
</tr>
<tr>
<td>Company</td>
<td>User company.</td>
<td>Alt+C</td>
</tr>
<tr>
<td>Department</td>
<td>User department.</td>
<td>Alt+R</td>
</tr>
<tr>
<td>Address</td>
<td>User mailing address.</td>
<td>Alt+D</td>
</tr>
<tr>
<td>City</td>
<td></td>
<td>Alt+I</td>
</tr>
<tr>
<td>Postal Code</td>
<td></td>
<td>Alt+P</td>
</tr>
<tr>
<td>State/Province</td>
<td></td>
<td>Alt+V</td>
</tr>
<tr>
<td>Country</td>
<td></td>
<td>Alt+U</td>
</tr>
<tr>
<td>Telephone</td>
<td>User telephone number.</td>
<td>Alt+O</td>
</tr>
<tr>
<td>Mobile</td>
<td>User mobile telephone number.</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Fax</td>
<td>User fax number.</td>
<td>Alt+X</td>
</tr>
<tr>
<td>Pager</td>
<td>User pager number.</td>
<td>Alt+G</td>
</tr>
</tbody>
</table>
User Roles tab—List descriptions

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Roles</td>
<td>Roles that are not associated with the selected user.</td>
</tr>
<tr>
<td>Selected Roles</td>
<td>Roles that are associated with the selected user.</td>
</tr>
</tbody>
</table>

Skills tab—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Fluencies</td>
<td>Languages in which the user is fluent. A user must be designated as fluent in a language in order to translate information into that language in the Central Designer application.</td>
</tr>
</tbody>
</table>

Categorization tab—List descriptions

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate with keywords</td>
<td>Selected keywords are associated with the user.</td>
</tr>
<tr>
<td>Associate with categories</td>
<td>Selected categories are associated with the user.</td>
</tr>
</tbody>
</table>

Create User and Copy User dialog boxes—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Name that is entered in the User Name field when a user is created. The User Name is used to log on to the Central Designer or Central Designer Administrator application. This field is searched when you search for a user in the Central Designer Administrator application.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You cannot modify a user name after the user has been created.</td>
</tr>
<tr>
<td>Display Name</td>
<td>User name that appears in the title bar in the Central Designer application. The Display Name field is searched when you search for a user in the Users Browser in the Central Designer application.</td>
</tr>
<tr>
<td>Password</td>
<td>User password for logging on.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>User password, repeated for confirmation purposes.</td>
</tr>
</tbody>
</table>
# Change Password dialog box—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Password</td>
<td>New password for the user for logging on to the Central Designer or Central Designer Administrator application.</td>
</tr>
<tr>
<td>Confirm</td>
<td>New password for the user, repeated for confirmation purposes.</td>
</tr>
</tbody>
</table>
CHAPTER 4
Role administration

In this chapter

Working with roles .................................................................38
About the Roles workspace....................................................41
Option descriptions for the Roles view and workspace ............44
Default roles ..........................................................................46
Working with roles

Refresh the Roles workspace

Refreshing the Roles workspace reloads information from the database.

- On the general toolbar, click Refresh.

Creating a role

You cannot modify the scope of a role after it has been created.

1. Click the Roles button.

2. Click Create Role.

   or

   Right-click within the Roles list, and select Create Role.

   or

   Press Ctrl+N.

   The Create Role dialog box appears.

3. Fill in the fields in the dialog box, and click OK.

   The role is added to the Roles list, and details for the role appear in the Roles workspace.

4. In the Roles workspace, define the properties, rights, and users associated with the role:

   a. In the Properties tab, fill in the fields.

   b. In the Rights tab, select one or more rights to be associated with the role.

   c. In the Users tab, select one or more users to assign to the role.

5. Click Save.

For more information, see:

Create Role dialog box - Field descriptions (on page 45).

Properties tab - Field descriptions (on page 44).

List descriptions for the Users tab (on page 45).

Deleting a role

1. Click the Roles button.

2. In the Roles list, right-click the role you want to delete, and then select Delete Role, or press Delete.

3. Click Save.

**Note:** A DesignerAdministrator role comes with the application by default and cannot be deleted.
Copy a Role

When you copy a role, the new role has the same rights and properties as the existing role but has a unique name. You can modify the rights and properties of a role that is created by copying another role. Consider copying a role if you need to create several similar roles.

1. Click the Roles button.
2. In the Roles list, select a role.
   The Roles workspace appears.
3. Right-click the role, and select Copy Role.
   or
   On the toolbar, click Copy Role.
   or
   Press Ctrl+C.
   The new role appears in the Roles list with the name of NewRole. All other properties, rights, and users from the original role are copied to the new role.
4. In the Name field, type a name for the role.
5. Modify the properties, rights, and users for this role as necessary:
   a. In the Properties tab, fill in the fields.
   b. In the Rights tab, select one or more rights to be associated with the role.
   c. In the Users tab, select one or more users to assign to the role.
6. Click Save.

For more information, see:

Properties tab - Field descriptions (on page 44).
Users tab - List description (on page 45).

Modifying the Name or Description of a Role

You cannot modify the scope of a role after it has been created.

1. Click the Roles button.
2. In the Roles list, select the role whose properties you want to modify.
   The Roles workspace appears.
3. Select the Properties tab.
4. Modify the information in the Name or Description field as necessary, and click Save.

Assigning Rights to a Role

1. Click the Roles button.
2. In the Roles list, select a role.
Chapter 4 Role administration

The Roles workspace appears.
3 Select the Rights tab.
4 Select the rights to assign to the role. If you select a named set of rights, all of the associated rights listed below the group name are also selected.
5 Click Save.

Removing rights from a role
1 Click the Roles button.
2 In the Roles list, select a role.
   The Roles workspace appears.
3 Select the Rights tab.
4 Deselect the rights that you want to remove from the role.
5 Click Save.

Assigning one or more users to a single role
1 Click the Roles button.
2 In the Roles list, select a role.
   The Roles workspace appears.
3 Select the Users tab.
4 In the Available Users action list, select a user, and click the right arrow button.
   Note: To select more than one user, use Ctrl+click or Shift+click.
   The user is added to the Selected Users action list and is assigned to the role.
5 Click Save.

Removing a user from a role
1 Click the Roles button.
2 In the Roles list, select the role from which you want to remove a user.
   The Roles workspace appears.
3 Select the Users tab.
4 In the Selected Users action list, select the user that you want to remove from the role and click the left arrow button.
   Note: To select more than one user, use Ctrl+click or Shift+click.
   The user is moved to the Available Users action list.
5 Click Save.
About the Roles workspace

In the Roles workspace, you perform role administration, which consists of managing tasks that users perform in the Central Designer and Central Designer Administrator applications, assigning rights to roles, and assigning roles to users. Tasks include the following:

- Creating, copying, and deleting roles. Roles created in the Central Designer Administrator application appear as teams in the Central Designer application.
- Modifying the name and description of a role.
- Assigning rights to a role.
- Assigning one or more users to a role.

The Roles workspace contains:

- A list of all Central Designer roles.
- Tabs in which you customize role information. The tabs appear only after you select a role.

Properties tab

In the Properties tab of the Roles workspace, you modify the name or description of a role.

To open the Properties tab:

1. Click the Roles button.
2. In the Roles list, select a role.

   The Roles workspace appears with the Properties tab selected by default.

For more information, see Properties tab - Field description (on page 44).

Rights tab

In the Rights tab of the Roles workspace, you can:

- Assign rights to a role (on page 39).
- Remove rights from a role (on page 40).

You can configure rights for library, study, and application roles. The rights that appear in the Rights tab depend on the scope of the selected role (library, study, or application). For example, the rights associated with a library role are different from the rights associated with a study role.

To open the Rights tab:

1. Click the Roles button.
2. In the Roles list, select a role.
   
   The Roles workspace appears.
3. Select the Rights tab.
About assigning users to roles

You can assign users to roles in both the Users and Roles workspaces. When you assign a user to a role, you authorize the user to assume the role in the studies or libraries where the user is a member of the corresponding team.

- A user assigned to a study role is granted the rights associated with the role only in studies where the user is also a member of the study team. For example, if a user is assigned to the Rule Creation study role in the Central Designer Administrator application, the user must also be a member of the Rule Creation study team for a study to create rules in the study.

- A user assigned to a library role is granted the rights associated with the role only in libraries where that user is also a member of the library team. For example, if a user is assigned to the Librarian library role in the Central Designer Administrator application, the user must be a member of the Librarian library team for a library (in the Central Designer application) to work in the library.

Note: You assign users to roles in the Central Designer Administrator application and to study and library teams in the Central Designer application.

You can assign a single user to multiple roles, and assign multiple users to a single role, as shown in the following illustration.

1—In the Users workspace, you can assign a single user to multiple roles.

2—In the Roles workspace, you can assign multiple users to a single role.

To grant rights to a user, you must first assign rights to a role, and then assign the user to that role.
Users tab

In the Users tab of the Roles workspace, you can:

- **Assign one or more users to a single role** (on page 40).
- **Remove a user from a role** (on page 40).

**Note**: A user assigned to a role has all of the rights associated with that role.

To open the Users tab:

1. Click the **Roles** button.
2. In the **Roles** list, select a role.
   
   The Roles workspace appears.
3. Select the **Users** tab.

For more information, see **Users tab - List descriptions** (on page 45).
Option descriptions for the Roles view and workspace

Properties tab—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the role.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the role.</td>
</tr>
<tr>
<td>Scope</td>
<td>Scope of the role:</td>
</tr>
</tbody>
</table>

- **Library**—A user assigned to a library role is granted the rights associated with the role only in libraries where that user is also a member of the library team. For example, if a user is assigned to the Librarian library role in the Central Designer Administrator application, the user must be a member of the Librarian library team for a library (in the Central Designer application) to work in the library.

- **Study**—A user assigned to a study role is granted the rights associated with the role only in studies where the user is also a member of the study team. For example, if a user is assigned to the Rule Creation study role in the Central Designer Administrator application, the user must also be a member of the Rule Creation study team for a study to create rules in the study.

- **Application**—A user assigned to an application role is granted all of the rights that are associated with the role, without restrictions. For example, a user who has the right to create users can always create users.

**Note:** You assign users to roles in the Central Designer Administrator application and to study and library teams in the Central Designer application.

For more information about role scopes and the rights they grant, see *Rights descriptions* (on page 101).

<table>
<thead>
<tr>
<th>Approval Policies section</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Role</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Approval Meaning</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>

Rights tab—Option descriptions

The Rights tab in the Roles workspace has rights that you can associate with a role. For descriptions of the rights, see *Rights descriptions* (on page 101).
Users tab—List descriptions

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Users</td>
<td>All users that have been created in the Central Designer Administrator application but are not assigned to the selected role.</td>
</tr>
<tr>
<td>Selected Users</td>
<td>All users that have been assigned to the selected role.</td>
</tr>
</tbody>
</table>

Create Role dialog box—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the role.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the role.</td>
</tr>
<tr>
<td>Scope</td>
<td>Scope of the role:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Library</strong>—A user assigned to a library role is granted the rights associated with the role only in libraries where that user is also a member of the library team. For example, if a user is assigned to the Librarian library role in the Central Designer Administrator application, the user must be a member of the Librarian library team for a library (in the Central Designer application) to work in the library.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Study</strong>—A user assigned to a study role is granted the rights associated with the role only in studies where the user is also a member of the study team. For example, if a user is assigned to the Rule Creation study role in the Central Designer Administrator application, the user must also be a member of the Rule Creation study team for a study to create rules in the study.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Application</strong>—A user assigned to an application role is granted all of the rights that are associated with the role, without restrictions. For example, a user who has the right to create users can always create users.</td>
</tr>
</tbody>
</table>

**Note:** You assign users to roles in the Central Designer Administrator application and to study and library teams in the Central Designer application.

For more information about role scopes and the rights they grant, see *Roles workspace—Right descriptions* (on page 102).
Default roles

Rights assigned to the StudyDesigner role

This role is an Application role, so the assigned rights are all Application rights.

For rights descriptions, see *Rights descriptions* (on page 101).

<table>
<thead>
<tr>
<th>Rights group</th>
<th>Selected rights</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Administration</strong> (on page 103)</td>
<td>Log on to the Central Designer application.</td>
</tr>
<tr>
<td>(Right group is not selected.)</td>
<td></td>
</tr>
<tr>
<td><strong>Catalog Administration</strong> (on page 103)</td>
<td>All rights within this category are selected.</td>
</tr>
<tr>
<td><strong>Search</strong> (on page 106)</td>
<td>All rights within this category are selected.</td>
</tr>
</tbody>
</table>

Rights assigned to the StudyAdministrator role

This role is an Application role, so the assigned rights are all Application rights.

For rights descriptions, see *Rights descriptions* (on page 101).

<table>
<thead>
<tr>
<th>Rights group</th>
<th>Selected rights</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Administration</strong> (on page 103)</td>
<td>Log on to the Central Designer software</td>
</tr>
<tr>
<td>(Right group is not selected.)</td>
<td></td>
</tr>
<tr>
<td><strong>Study Administration</strong> (on page 107)</td>
<td>All rights within this category are selected.</td>
</tr>
<tr>
<td><strong>Library Administration</strong> (on page 105)</td>
<td>All rights within this category are selected.</td>
</tr>
<tr>
<td><strong>Catalog Administration</strong> (on page 103)</td>
<td>All rights within this category are selected.</td>
</tr>
<tr>
<td><strong>Search</strong> (on page 106)</td>
<td>All rights within this category are selected.</td>
</tr>
</tbody>
</table>

Rights assigned to the DesignerAdministrator role

All Application rights are selected. For more information, see *Application roles—Rights descriptions* (on page 103).
CHAPTER 5

System configuration administration

In this chapter

Working with supported locales ................................................................. 48
Working with target applications ................................................................. 50
Working with sponsors .............................................................................. 51
Working with note types and task types ...................................................... 52
Working with custom properties ................................................................. 56
Working with report definitions ................................................................. 67
Working with units definitions ................................................................. 68
Working with coding information ............................................................... 69
Working with security settings .................................................................. 75
Working with supported locales

Checklist—Setting up in Central Designer Administrator for translating text strings

Perform these steps as needed, in any order.

Note: Perform each step in this checklist in the Central Designer Administrator application.

<table>
<thead>
<tr>
<th>Workflow step</th>
<th>Where to get more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the System Config &gt; General &gt; Supported Locales area, select each locale that you expect to be supported by studies designed in the Central Designer application. <a href="#">System Configuration administration</a> (on page 47).</td>
</tr>
<tr>
<td>2</td>
<td>In the Users &gt; User Roles area, assign roles that include the Translate Study Resources right to users who are responsible for translating. <a href="#">User administration</a> (on page 17).</td>
</tr>
<tr>
<td>3</td>
<td>In the Users &gt; Skills area, assign language fluency skills to users who are responsible for translating. <a href="#">User administration</a> (on page 17).</td>
</tr>
</tbody>
</table>

Adding and removing a locale

You can add and remove one or more locales at the same time.

To add one or more locales:

1. Select System Config.
2. In the General section, click the Supported Locales link.
   The Supported Locales workspace appears.
3. Click Add (located in the upper-right corner).
   The Add Locale dialog box appears.
4. Select the checkboxes next to the locales that you want to add to the supported locales list, and click OK.
   The locales are added to the list.
5. Click Save.

To remove one or more locales:

1. Select System Config.
2. In the General section, click the Supported Locales link.
The Supported Locales workspace appears.

3 Select the checkbox next to the locale you want to remove, and click **Remove**.

   The locale is removed from the list.

4 Click **Save**.

**Supported Locales workspace**

In the Supported Locales workspace, you define the locales to support for study design. A locale is a supported language or language variation.

You can design and deploy studies in every language and locale that is installed with the Microsoft Windows operating system, but only the languages and locales that you specify are available when a study is created in the Central Designer application.

**Note:** You must select at least one locale to design studies.

**To open the Supported Locales workspace:**

1 Click the **System Config** button.

2 Under **General**, click **Supported Locales**.

For more information, see **Supported Locales workspace - Field descriptions** (on page 49).

**Supported Locales workspace—Field descriptions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locale</td>
<td>A supported language or language variation.</td>
</tr>
</tbody>
</table>
Working with target applications

Targets workspace

In the Targets workspace, you enable and disable available target applications. A target application is an application to which you deploy a Central Designer study. For example, you can use the Central Designer application to design a study and deploy that study to the InForm application. The InForm application is the target application.

To open the Targets workspace:

1. Click the System Config button.
2. Under General, click Targets.

For more information, see Targets workspace—Field descriptions (on page 50).

Targets workspace—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the installed target application.</td>
</tr>
<tr>
<td>Version</td>
<td>Installation version associated with the target application. This field is incremented each time a new version of the target application is installed.</td>
</tr>
<tr>
<td>Enabled</td>
<td>If selected, allows study objects for the target application to appear in the Central Designer application.</td>
</tr>
</tbody>
</table>
Working with sponsors

Sponsors workspace

In the Sponsors workspace, you add sponsors, which are then made available in the Central Designer application to be assigned to studies. You can also populate the Sponsors workspace by entering a sponsor name in the Sponsor drop-down list on the General tab for a study in the Central Designer application. The sponsor name then appears in the Sponsors workspace, and is available for use with other studies.

To open the Sponsors workspace:

1. Click the System Config button.
2. Under General, click Sponsors.

For more information, see Sponsors workspace—Field descriptions (on page 51).

Sponsors workspace—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sponsor.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the sponsor.</td>
</tr>
</tbody>
</table>
Working with note types and task types

Adding, modifying, and deleting a collaboration note type

If collaboration notes that are based on a collaboration note type exist, you cannot delete the collaboration note type.

To add a collaboration note type:
1. Select System Config.
2. In the Collaboration section, click the Note Types link.
   The Note Types workspace appears, and information about existing collaboration note types appears, followed by a blank row.
3. Fill in the fields in the blank row, and click Save.

To modify a collaboration note type:
1. Select System Config.
2. In the Collaboration section, click the Note Types link.
   The Note Types workspace appears, and information about existing collaboration note types appears, followed by a blank row.
3. Select the type that you want to modify.
4. For the selected type, click in a field and modify the information as necessary.
5. Click Save.

To delete a collaboration note type:
1. Select System Config.
2. In the Collaboration section, click the Note Types link.
   The Note Types workspace appears, and information about existing collaboration note types appears, followed by a blank row.
3. Right-click the type you want to delete, and select Delete Row.

For more information, see Note Types workspace - Field descriptions (on page 54).

Adding, modifying, and deleting a task type

If tasks that are based on a task type exist, you cannot delete the task type.

To add a task type:
1. Select System Config.
2. In the Collaboration section, click the Task Types link.
   The Task Types workspace appears. It contains information about existing task types, followed by a blank row.
3. Fill in the fields in the blank row, and click Save.
To modify a task type:

1. Select **System Config**.
2. In the **Collaboration** section, click the **Task Types** link.
   - The Task Types workspace appears. It contains information about existing task types, followed by a blank row.
3. Select the type that you want to modify.
4. For the selected type, click a field, and modify the information as necessary.
5. Click **Save**.

To delete a task type:

1. Select **System Config**.
2. In the **Collaboration** section, click the **Task Types** link.
   - The Task Types workspace appears. It contains information about existing task types, followed by a blank row.
3. Right-click the type you want to delete, and select **Delete Row**.

For more information, see **Task Types workspace - Field descriptions** (on page 54).

---

**Note Types and Task Types workspaces**

### Note Types workspace

In the Note Types workspace, you define collaboration note types. A collaboration note type is a classification used to identify the type and purpose of a collaboration note. For example, you can use an Informational note type to create notes that provide information about a study object.

**To open the Note Types workspace:**

1. Click the **System Config** button.
2. Under **Collaboration**, click **Note Types**.

For more information, see **Note Types workspace - Field descriptions** (on page 54).

### Task Types workspace

In the Task Types workspace, you create task types. A task type is a classification used to identify the type of the task and the way the task is used. For example, you can use a Create Form task type for assigning form creation work.

**Definitions of task types**

For each task type, you define:

- A classification, which identifies the purpose of a task. The options are Standard and Translation.
- A study or library team to which tasks of that type are assigned by default.
  - For Standard tasks, specifying a team is optional, and Central Designer users can override the default assignment.
• For Translation tasks, you must specify a team, and Central Designer users cannot override the assignment. In the Central Designer application, only the users with the language fluency skills for the requested translation work can view the translation task.

Note: Study and library roles appear as study and library teams in the Central Designer application.

Sample task types

You can choose the level of detail that you need for task types. For example, you can have a generic Work request task type, or you can create specific types such as:

• Rule design
• Layout design
• Translation

If people frequently require clarification about tasks that are assigned to them and you need to track the requests for additional information, consider creating a Clarification task type that people can use to obtain additional information.

To open the Task Types workspace:

1. Click the System Config button.
2. Under Collaboration, click Task Types.

For more information, see Task Types workspace - Field descriptions (on page 54).

Note Types workspace—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the collaboration note type.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the collaboration note type.</td>
</tr>
</tbody>
</table>

Task Types workspace—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the task type.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the task type.</td>
</tr>
<tr>
<td>Task Classification</td>
<td>Classification of the task.</td>
</tr>
<tr>
<td></td>
<td>• Standard—Used for all non-translation tasks assigned to an individual or team.</td>
</tr>
<tr>
<td></td>
<td>• Translation—Used for tasks that request translation of a study object into one or more languages.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Study or library team to which tasks of this type are assigned by default.</td>
</tr>
</tbody>
</table>

**Notes:**

- Study and library roles appear as study and library teams in the Central Designer application.
- The default team for translation tasks cannot be overridden in the Central Designer application.
- For translation tasks, members of the team see a task only if they are fluent in the language to which the study object needs to be translated.
Working with custom properties

Adding, modifying, and removing a custom property

You can add a custom property to a grouping and remove a custom property from the grouping.

- If you remove a custom property, the property is removed from the Properties Browser in the Central Designer application and is no longer associated with any study objects for which the property value was assigned. Oracle recommends that you do not delete custom properties.
- You must not delete InForm or Clintrial custom properties, or deployment is likely not to succeed.
- Do not modify InForm or Clintrial custom properties or groupings.
- You cannot rename custom properties or groupings.

To add a custom property:

1. Select **System Config**.
2. In the **Customization** section, click the **Custom Properties** link.
   
   The Custom Properties workspace appears.
3. In the Custom Properties list, right-click a grouping, and select **Add Custom Property**, or press **Ctrl+N**.
   
   A new custom property appears in the Custom Properties list, and details for the custom property appear in the workspace.
4. Fill in the fields in the workspace, and click **Save**.

To modify a custom property:

1. Select **System Config**.
2. In the **Customization** section, click the **Custom Properties** link.
   
   The Custom Properties workspace appears.
3. Select a custom property.
   
   The custom property appears in the Custom Properties workspace.
4. Modify the fields as necessary, and click **Save**.

To remove a custom property:

1. Select **System Config**.
2. In the **Customization** section, click the **Custom Properties** link.
3. Right-click a custom property, and select **Remove**, or press **Delete**.
4. Click **Save**.

For more information, see **Custom Properties workspace - Field descriptions** (on page 65).
Adding and removing a grouping

You can create a grouping under a study object in the Custom Properties workspace. After you create a grouping, you can add a custom property to the grouping.

Notes:

- Do not modify InForm or Clintrial custom properties or groupings.
- You cannot rename custom properties or groupings.

To add a grouping:

1. Select System Config.
2. In the Customization section, click the Custom Properties link. The Custom Properties workspace appears.
3. Right-click a study object, and select Add Grouping, or press Ctrl+N, and then type the name of the grouping.
   or
   Select a study object, and type the name of the grouping in the blank field in the Groupings grid in the workspace.
4. Press Enter.
5. Click Save.

To remove a grouping:

1. Select System Config.
2. In the Customization section, click the Custom Properties link. The Custom Properties workspace appears.
3. Right-click a grouping, and select Remove, or press Delete.
4. Click Save.

Moving, cutting, copying, and pasting a grouping

When you cut or copy and then paste a grouping that contains one or more custom properties, the custom properties are copied or cut and then pasted with the grouping.

To move a grouping:

1. Select System Config.
2. In the Customization section, click the Custom Properties link. The Custom Properties workspace appears.
3. Drag a grouping from one study object to the other study object name.

To cut or copy and then paste a grouping:

1. Select System Config.
2. In the Customization section, click the Custom Properties link.
The Custom Properties workspace appears.

3 Right-click a grouping, and then select either Copy (or press Ctrl+C) or Cut (or press Ctrl+X).

4 Right-click a study object, and select Paste, or press Ctrl+V.

The grouping is moved.

**Custom Properties workspace**

All study objects have standard properties for which you view, define, and modify values in the Properties Browser.

If you want to provide additional information about a study object, then you create custom properties in the Central Designer Administrator application. A custom property is a user-defined or default characteristic of a study object. You can create custom properties for study designs, study elements, study events, forms, items, codelists, codelist items, logical schemas, data sets, and data series. After an administrator creates custom properties for the study objects in the Central Designer Administrator application, Central Designer users can define values for custom properties in the Properties Browser in the Central Designer application.

Custom properties are organized in both applications by study object and then by grouping. A grouping is a default or user-provided value used to organize custom properties of a study object.

For example, you can create a custom property that allows Central Designer users to select the dictionary used to code an item. You can specify values for the dictionaries, and users can either select a dictionary from a list or type a dictionary name.

**Note:** In the Central Designer application, all custom properties appear in the Categories tree, so users can include custom properties and their values in search parameters.

To open the Custom Properties workspace:

1 Click the System Config button.

2 Under Customization, click Custom Properties.
Illustration of the Custom Properties workspace

The Custom Properties workspace displays context-sensitive information, depending on what you select in the Custom Properties tree.

1—When a study object is selected, the workspace displays the groupings created under the study object. Groupings organize properties in the Properties Browser in the Central Designer application.

2—When a grouping is selected, the workspace displays all custom properties created in the grouping. Some custom properties are predefined.

3—When a custom property is selected, the workspace displays details related to the custom property. You can define this information.

For more information, see Custom Properties workspace - Field descriptions (on page 65).

InForm and Clintrial custom properties

The following InForm and Clintrial custom properties are available by default in the Custom Properties workspace.

Note: You must not delete InForm or Clintrial custom properties, or deployment is likely not to succeed.
For a list of CDD and CIS custom properties, see *CDD mapping properties* and *CIS mapping properties* (in InForm Design Guide).

<table>
<thead>
<tr>
<th>Study object</th>
<th>Custom property</th>
<th>Description and default values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Miscellaneous custom properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Study Design</td>
<td>Sponsor</td>
<td>Name of the sponsor of the study.</td>
</tr>
<tr>
<td></td>
<td>Sponsor Date</td>
<td>Date specified by the sponsor of the study.</td>
</tr>
<tr>
<td></td>
<td>Generic Drug Name</td>
<td>Generic name for a drug.</td>
</tr>
<tr>
<td></td>
<td>Sponsor Drug Name</td>
<td>Code name given to a drug by a sponsor.</td>
</tr>
<tr>
<td></td>
<td>Trade Drug Name</td>
<td>Commercial name of a drug.</td>
</tr>
<tr>
<td><strong>InForm custom properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Study Design</td>
<td>Shared Form Block Key</td>
<td>Block key to use for a shared form. You must use this property if the block key in the Clintrial application is defined as a numeric field. The block key that you specify overrides the internal text block key (CommonCRF) that the Central Designer application creates during deployment from the system RefName of the special visit for shared forms.</td>
</tr>
<tr>
<td>Study Event</td>
<td>Optional</td>
<td>True or False (default), indicating whether the formset (visit) is optional or required.</td>
</tr>
<tr>
<td>Form</td>
<td>Special Visits</td>
<td>Indicates if the study event holds a Screening or Enrollment form.</td>
</tr>
<tr>
<td></td>
<td>None (Default; study event does not have a Screening or Enrollment form).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screening.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enrollment.</td>
<td></td>
</tr>
<tr>
<td>Item Required</td>
<td>True (default) or False, indicating whether the item is required.</td>
<td></td>
</tr>
<tr>
<td>SDV Required</td>
<td>True (default) or False, indicating whether the item requires source verification.</td>
<td></td>
</tr>
<tr>
<td>Study object</td>
<td>Custom property</td>
<td>Description and default values</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Special Forms</td>
<td></td>
<td>Forms that have special processing in the InForm software.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Screening</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enrollment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Patient Identification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Study Completion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (Available only in the NonClinical container) Reg Docs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (Available only in the NonClinical container) Visit Report</td>
</tr>
</tbody>
</table>

| SDV Critical      |                     | True (default) or False, indicating whether the item requires source verification.                |

<table>
<thead>
<tr>
<th>Item</th>
<th>Display Override</th>
<th>Determines the default behavior of an item when a layout is generated.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• <strong>ReadOnly</strong>—The item is visible but not editable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Editable</strong>—The item is visible and editable by any user, regardless of the rights assigned to the user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Hidden</strong>—The item is not visible.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>None</strong>—The item is visible to all users, and visible and editable by any user who has the rights to view and/or edit the item.</td>
</tr>
</tbody>
</table>

| Item Required     |                     | **True** (default) or **False**, indicating whether the item is required for data entry on the form to be complete. |

| SDV Required      |                     | **True** (default) or **False**, indicating whether the item requires source document verification. |
### Chapter 5  System configuration administration

<table>
<thead>
<tr>
<th>Study object</th>
<th>Custom property</th>
<th>Description and default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Fields</td>
<td></td>
<td>Fields used on the special forms for the InForm application.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
<td>Field is not a special InForm field.</td>
</tr>
<tr>
<td></td>
<td><strong>Screening form:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Initials</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• DOB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Screening date</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Enrollment form:</strong></td>
<td>Patient No.</td>
</tr>
<tr>
<td></td>
<td><strong>Patient Identification form:</strong></td>
<td>Initials</td>
</tr>
<tr>
<td></td>
<td><strong>Study Completion form:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Completion status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Drop out reason</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Date of Visit form:</strong></td>
<td>DOV</td>
</tr>
<tr>
<td></td>
<td><strong>Randomization form:</strong></td>
<td>Randomization field</td>
</tr>
<tr>
<td>MinValue</td>
<td></td>
<td>Minimum value that the InForm application will allow to be typed for the item.</td>
</tr>
<tr>
<td>MaxValue</td>
<td></td>
<td>Maximum value that the InForm application will allow to be typed for the item.</td>
</tr>
<tr>
<td>MinProperty</td>
<td><strong>True</strong> or <strong>False</strong>, indicating whether MinValue is inclusive of the number typed.</td>
<td></td>
</tr>
<tr>
<td>MaxProperty</td>
<td><strong>True</strong> or <strong>False</strong>, indicating whether MaxValue is inclusive of the number typed.</td>
<td></td>
</tr>
<tr>
<td>SDV Critical</td>
<td>True (default) or False, indicating whether the item is marked as critical.</td>
<td></td>
</tr>
<tr>
<td>Codelist Item</td>
<td></td>
<td>Codelist items in the codelist for the Completion Status item on the Study Completion form, which is used in reporting in the InForm application to determine whether a subject dropped out of a study. Options include:</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
<td>(default) The codelist item is not part of the codelist for the Completion Status item.</td>
</tr>
<tr>
<td></td>
<td><strong>Complete Study (Study Completion)</strong></td>
<td>Indicates that the subject has completed the study.</td>
</tr>
<tr>
<td></td>
<td><strong>Incomplete Study (Study Completion)</strong></td>
<td>Indicates that the subject has not completed the study.</td>
</tr>
</tbody>
</table>

**Clintrial custom properties**
<table>
<thead>
<tr>
<th>Study object</th>
<th>Custom property</th>
<th>Description and default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Study Event</td>
<td>Repeats Limit</td>
<td>Maximum number of times a block can repeat. Set to -1 for unlimited repeats.</td>
</tr>
<tr>
<td>Form</td>
<td>Verifiable</td>
<td>Indicates whether the panel needs to be verified in the Clintrial application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0—(default) Verification is not required before data in the panel can be validated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—Verification is required before data in the panel can be validated.</td>
</tr>
<tr>
<td>Protected</td>
<td></td>
<td>Indicates if the panel is protected in the Clintrial application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0—(default) Panel is not protected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—Panel is protected.</td>
</tr>
<tr>
<td>MaxRepeats</td>
<td></td>
<td>Maximum number of repeating records that are allowed in a page section.</td>
</tr>
<tr>
<td>Type</td>
<td></td>
<td>Type of panel in the Clintrial application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0—Type 0 panel (non-patient data).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—(default) Type 1 panel (one record per patient).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2—Type 2 panel (more than one record per patient).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3—Type 3 panel (one record per patient visit).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 4—Type 4 panel (more than one record per patient visit).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 5—Type 5 panel (subject enrollment).</td>
</tr>
<tr>
<td>Audit Start</td>
<td></td>
<td>Default audit start point for all protocols in the Clintrial database instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ENTRY—Auditing begins after data has been entered interactively in a record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VERIFICATION—Auditing begins after data has been re-entered to check the accuracy of the entry or, for batch-loaded records, after data has been screened.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VALIDATION—Auditing begins after a record has been validated, regardless of whether the record passed or failed validation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VALIDITY—Auditing begins after a record has passed validation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MERGE—Auditing begins after data has moved from the update table to the data table.</td>
</tr>
<tr>
<td>Item</td>
<td>SAS Name</td>
<td>Name of the item when data is sent to a SAS dataset through the Clintrial SAS interface. This attribute must be no more than eight characters, and it must conform to SAS requirements.</td>
</tr>
</tbody>
</table>
### Custom properties in the Central Designer application

A custom property created for a study object (for example, an item) appears in the Properties Browser for all study objects of that type (in this case, all items).

1—A portion of the Custom Properties workspace in the Central Designer Administrator application.
A portion of the Properties Browser in the Central Designer application. Custom properties defined under the Clintrial grouping appear in the Central Designer application under the same Clintrial grouping, and custom properties defined under the InForm grouping appear in the Central Designer application under the same InForm grouping.

**Custom Properties workspace—Field descriptions**

The fields that appear in the Custom Properties workspace vary according to what you select. You can select a study object, a grouping, or a custom property.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A study object is selected.</td>
<td>Name of the grouping for the study object.</td>
</tr>
<tr>
<td>Groupings</td>
<td>Groupings organize custom properties in the Central Designer application.</td>
</tr>
<tr>
<td>A grouping is selected.</td>
<td>Name of the custom property created under the grouping for a study object.</td>
</tr>
<tr>
<td>Custom Properties</td>
<td>Name of the custom property created under the grouping for a study object.</td>
</tr>
<tr>
<td>A custom property is selected.</td>
<td>Name of the custom property.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the custom property.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Data type of the custom property:</td>
</tr>
<tr>
<td></td>
<td>• Text—Contains alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td>• Integer—Contains only numbers.</td>
</tr>
<tr>
<td></td>
<td>• Boolean—True or False.</td>
</tr>
<tr>
<td></td>
<td>• Float—Contains numbers and a decimal point.</td>
</tr>
<tr>
<td>Max Length</td>
<td>Maximum number of characters allowed for the value of the custom property.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the custom property.</td>
</tr>
<tr>
<td>Make Property Visible</td>
<td>• Selected—Users can see this property in the Properties Browser in the Central Designer application.</td>
</tr>
<tr>
<td></td>
<td>• Not Selected—The property is not visible in the Properties Browser in the Central Designer application.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Use Value List     | • **Selected**—Central Designer users must select a value for the custom property from a list of possible values. You can define these values in the grid with the Value and Default fields.  
|                    | • **Not selected**—Central Designer users must supply a value for the custom property. |
|                    | The Use Value List grid has the following fields.                             |
|                    | • **Value**—A value for the custom property. All values are available in a drop-down list in the Central Designer application. If Use Value List is selected, Central Designer users must select a value for the custom property.  
|                    | • **Default**—When selected, the value is selected by default for the custom property in the Central Designer application. You can select the checkbox for only one value. |
Working with report definitions

Exporting the file for report definitions

If you have modified the XML definition file for reports, you must export it before you upgrade.

1. Select **System Config**
2. Under **Customization**, select **Reports Definitions**.
   
The Reports Definitions workspace appears.
3. Click **Save As**.
   
The Save As dialog box appears.
4. Provide a name for the file, browse to the location in which to save it, and click **Save**.

**Note:** After a Central Designer upgrade, you must re-import the report definitions. For more information, see **Updating report definitions** (on page 67). For information about developing and importing new custom reports, contact Oracle Services.

Updating report definitions

On each Central Designer application server:

1. Copy the updated custom reports definition file to the following location, overwriting the existing file:
   
   ```
   <designer_root>\DBSchema\Last\Datainstaller\DesignerReportsDefinitions.xml
   ```
   
   where `<designer_root>` is the root directory of the Central Designer installation.
2. From the `<designer_root>\bin` directory, run the **UpdateReports.bat** file.
   
The **UpdateReports.bat** file updates the definitions of the custom reports in the database.

Reports Definitions workspace

In the Reports Definitions workspace, you can export the currently defined reports definitions.

**To open the Reports Definitions workspace:**

1. Click the **System Config** button.
2. Under **Customization**, click **Reports Definitions**.
Working with units definitions

Exporting and importing a units file

If you have modified the units file, you should export it before you upgrade and then import it after you upgrade. To add new units, you can export the file, modify it, and import it at any time.

To import a units file:
1. Select System Config
2. Under Customization, select Unit Definitions.
   The Unit Definitions workspace appears.
3. Click Import.
   The Open dialog box appears.
4. Navigate to the location of the units file, and select it.
5. Click Open.

To export the units file that is in the database:
1. Select System Config.
2. Under Customization, select Unit Definitions.
   The Unit Definitions workspace appears.
3. Click Save As.
   The Save As dialog box appears.
4. Provide a name for the file, browse to the location in which to save it, and click Save.
   The file is saved.

Units Definitions workspace

In the Units Definitions workspace, you export the currently defined units definitions, modify the file outside of the application, and then import the modified file. You cannot modify a file that has already been imported.

Units information is used by all application servers in a web farm and is stored in the database.

To open the Units Definitions workspace:
1. Click the System Config button.
2. Under Customization, click Unit Definitions.
Working with coding information

Importing and overwriting a dictionary type

You can import dictionary types at any time. An imported dictionary type is enabled by default.

You cannot remove a dictionary type after importing it. If you want to update a dictionary type, you can either:

- Modify or rename the file and then import a new file.
- Overwrite the existing dictionary type.
- If the original dictionary type is used by one or more coding maps and updates to the dictionary type change its structure (for example, if coding levels are added or removed), you receive a message that indicates that the import cannot be done because the coding maps would be made invalid.

To import or overwrite a dictionary type:

1. Select System Config.
2. In the Coding section, click the Dictionary Types link.
   The Coding Dictionaries workspace appears.
3. Click Import.
   The Open dialog box appears.
4. Navigate to the location of the dictionary type file, select it, and click Open.
   If you are overwriting a dictionary type, a dialog box appears. Review and confirm the changes.
   The import might take a few moments. After the import is complete, you receive a message that the import is finished.
   An imported dictionary type is enabled by default. If you do not want the dictionary type to be available for creating coding maps, you can disable it.

Enabling and disabling a dictionary type

A dictionary type must be in the Central Designer Administrator application before you can enable it.

To make a dictionary type available to be added to a study or library, you must enable it. When a dictionary type is disabled, it cannot be added to any studies or libraries.

If you disable a dictionary type that is used by a study or library in the Central Designer application, Central Designer users can view its coding maps but cannot create or modify them.
To enable a dictionary type:

1. Select **System Config**.
2. In the **Coding** section, click the **Dictionary Types** link.
   
   The Coding Dictionaries workspace appears.
3. Select the **Enabled** checkbox for the dictionary.
4. Click **Save**.

To disable a dictionary type:

1. Select **System Config**.
2. In the **Coding** section, click the **Dictionary Types** link.
   
   The Coding Dictionaries workspace appears.
3. Deselect the **Enabled** checkbox for the dictionary.
4. Click **Save**.

Renaming a dictionary type

If you rename a dictionary type, the coding maps that were created for the dictionary type are still valid.

1. Select **System Config**.
2. In the **Coding** section, click the **Dictionary Types** link.
   
   The Coding Dictionaries workspace appears.
3. Click within a **Type** field for a dictionary type.
   
   The text becomes editable.
4. Type a new name for the dictionary type, and press **Enter**.
5. Click **Save**.

Adding, modifying, and deleting a verbatim type

1. Select **System Config**.
2. In the **Coding** section, click the **Verbatim Types** link.
   
   The Verbatim Types workspace appears. It displays information about existing verbatim types, followed by a blank row.
3. Do one of the following:
   
   - **To add a verbatim type**: Type the name and description in the blank row.
   - **To modify a verbatim type**: Double-click the text that you want to modify, and type the correct text. Click **Save**.
   - **To delete a verbatim type**: Right-click the verbatim type, and select **Delete Row**.

   **Note:** You cannot delete a verbatim type that is in use.
Importing and overwriting dictionary metadata

If a dictionary metadata update is implemented in the Central Coding application, you will need to update dictionary metadata items in the Central Designer application. Oracle will provide you with an XML file that you must import to continue using and creating coding maps in the Central Designer application.

**Note:** Do not import an XML file unless specifically directed by Oracle, or your coding maps will become invalid.

1. Select **System Config**.
2. In the **Coding** section, click the **Dictionary Metadata** link.
   
   The Coding Dictionaries Metadata workspace appears.
3. Click **Import**.
   
   The Open dialog box appears.
4. Navigate to the location of the dictionary metadata XML file, select it, and click **Open**.
   
   If existing coding maps reference a dictionary metadata item that will be removed as a result of the import, a dialog box appears to alert you of the changes.
   
   If no dictionary metadata items will be removed as a result of the import, or if the dictionary metadata items that will be removed are not used, the import begins immediately.
   
   The import might take a few moments. After the import is complete, you receive a message that the import is finished.

Dictionary Types workspace

In the Dictionary Types workspace, you import and enable dictionary types. You also can overwrite dictionary types. A dictionary type is a name or identifier for the metadata for a dictionary.

**About dictionary types**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition and purpose</strong></td>
<td>A dictionary type is a name or identifier for the metadata for a dictionary. You create a coding map for a verbatim using a dictionary type. The dictionary type specifies the metadata for all versions of a dictionary, including:</td>
</tr>
<tr>
<td></td>
<td>• Verbatim types.</td>
</tr>
<tr>
<td></td>
<td>• Dictionary levels.</td>
</tr>
<tr>
<td></td>
<td>• Dictionary level types, such as Term or Code.</td>
</tr>
<tr>
<td></td>
<td>• Where applicable, context meanings.</td>
</tr>
</tbody>
</table>
Chapter 5 System configuration administration

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dictionary types in the installation</td>
<td>The following dictionary types are installed with the Central Designer application:</td>
</tr>
<tr>
<td></td>
<td>• MedDRA—Medical Dictionary for Drug Regulatory Activities.</td>
</tr>
<tr>
<td></td>
<td>• JDrug—Japanese drug dictionary.</td>
</tr>
<tr>
<td>Importing</td>
<td>You can import other standard dictionary types as well as custom dictionary types in the Central Designer Administrator application.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Importing and overwriting a dictionary type (on page 69).</td>
</tr>
<tr>
<td>Multiple versions</td>
<td>The Central Designer application supports multiple versions of a dictionary type.</td>
</tr>
<tr>
<td></td>
<td>A version consists of dictionary metadata and dictionary data. In most cases, versions are different only in data, but new versions can also contain new metadata.</td>
</tr>
<tr>
<td>Using in a study or library</td>
<td>To use a coding dictionary in a study or library to create coding maps, you must use the following process:</td>
</tr>
<tr>
<td></td>
<td>1 Import the dictionary type (on page 69).</td>
</tr>
<tr>
<td></td>
<td>2 Enable the dictionary type (on page 69).</td>
</tr>
<tr>
<td></td>
<td>3 Select the dictionary type for a study or library (in the InForm Design Guide).</td>
</tr>
<tr>
<td>Association with verbatim types</td>
<td>You can associate multiple verbatim types with a single dictionary type.</td>
</tr>
<tr>
<td>Deployment</td>
<td>Dictionary types that are used in the coding maps are deployed to the InForm application as MedML DICTIONARY objects.</td>
</tr>
</tbody>
</table>

To open the Dictionary Types workspace:
1 Click the System Config button.
2 Under Coding, click Dictionary Types.

For more information, see Dictionary Types workspace - Field descriptions (on page 73)
Verbatim Types workspace

In the Verbatim Types workspace, you create and edit verbatim types. A verbatim type is a classification of a verbatim as defined in a coding dictionary.

Note: You associate verbatim types with dictionary types in the Study Editor in the Central Designer application.

About verbatim types

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition and purpose</td>
<td>A verbatim type is a classification of a verbatim as defined in a coding dictionary.</td>
</tr>
<tr>
<td>Verbatim types in the installation</td>
<td>• AE—Adverse Event</td>
</tr>
<tr>
<td></td>
<td>• DISEASE—Disease</td>
</tr>
<tr>
<td></td>
<td>• LABDATA—Lab data</td>
</tr>
<tr>
<td></td>
<td>• MEDPROD—Medical product</td>
</tr>
<tr>
<td>Association with dictionary types</td>
<td>You can associate multiple verbatim types with a single dictionary type.</td>
</tr>
</tbody>
</table>

To open the Verbatim Types workspace:

1. Click the System Config button.
2. Under Coding, click Verbatim Types.

Coding Dictionary Metadata workspace

In the Coding Dictionary Metadata workspace, you view existing dictionary metadata items and import new dictionary metadata items to overwrite the existing dictionary metadata items. A dictionary metadata item is an identifier that describes administrative data about a dictionary and that you can use to create a coding map.

To open the Coding Dictionary Metadata workspace:

1. Click the System Config button.
2. Under Coding, click Dictionary Metadata.

For more information, see Coding Dictionary Metadata workspace - Option descriptions (on page 74).
## Dictionary Types workspace—Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Name of the dictionary type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In the dictionary type XML file, this information comes from the DictionaryType field. You can modify this information by double-clicking the Type field.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the dictionary type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In the dictionary type XML file, this information comes from the Description field. You can modify this information by double-clicking the Description field.</td>
</tr>
<tr>
<td>Import date</td>
<td>Date on which the dictionary type was imported.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates whether the dictionary type is enabled. Only enabled dictionary types can be used to create coding definitions in the Central Designer application.</td>
</tr>
</tbody>
</table>

## Coding Dictionary Metadata workspace—Option descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the dictionary metadata item; either Dictionary or CoderName.</td>
</tr>
<tr>
<td>Version</td>
<td>Version number for the dictionary metadata item.</td>
</tr>
<tr>
<td>Level</td>
<td>Dictionary level for which a coding map can be defined for the metadata item; either Dictionary or CoderName.</td>
</tr>
<tr>
<td>Level Type</td>
<td>Information that indicates the type of supported target item for the dictionary metadata item. The only available option is Term.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the dictionary metadata item; either Dictionary or CoderName.</td>
</tr>
</tbody>
</table>
Working with security settings

Changing the security settings for accounts and sessions

1. Select **System Config**.
2. Under **Security**, select **Settings**.
3. Modify the settings as needed.

For more information, see:

- *Security settings workspace* (on page 75).
- *Security settings workspace—Option descriptions* (on page 75).

Security Settings workspace

In the Security Settings workspace, you view and modify the security settings for user accounts and logon sessions. For more information, see *Changing the security settings for accounts and sessions* (on page 75).

To open the Security Settings workspace:

1. Click the **System Config** button.
2. Under **Security**, click **Settings**.

For more information, see *Security Settings workspace - Option descriptions* (on page 75).

Security Settings workspace—Option descriptions

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default value</th>
<th>Acceptable range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Passwords section</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Passwords expire every</td>
<td>When selected, passwords expire after the specified number of days.</td>
<td>30 days</td>
<td>1 day - 365 days</td>
</tr>
<tr>
<td></td>
<td>Otherwise, passwords do not expire.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enforce password history</td>
<td>When selected, you can specify the number of recently used passwords that cannot be reused. For example, if you specify 4 in the <strong>Enforce password history</strong> field, when changing a password, users cannot use any of their four previously used passwords.</td>
<td>4</td>
<td>4-12 passwords</td>
</tr>
<tr>
<td>Minimum password length</td>
<td>Minimum required length of a password for any user.</td>
<td>8 characters</td>
<td>6 - 20 characters</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default value</td>
<td>Acceptable range</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Number of password re-tries</td>
<td>Number of failed logon attempts that are allowed before a user's account is locked. A user with a locked account cannot log on for 30 minutes.</td>
<td>3 attempts</td>
<td>1 - 10 attempts</td>
</tr>
<tr>
<td>Password complexity</td>
<td>Low—The password must meet the length requirement.</td>
<td>High</td>
<td>Not applicable.</td>
</tr>
<tr>
<td></td>
<td>Medium, High, or Very High—The password must meet the length requirement and meet one (for Medium), two (for High), or all (for Very High) of the following requirements:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• At least one letter and one number.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• At least one non-alphanumeric character.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• At least one upper-case and one lower-case letter.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account lockout section</td>
<td>Lockout System account for Amount of time the system user account is locked out of the Central Designer application after exceeding the allowed number of login attempts.</td>
<td>30</td>
<td>0 minutes - 23 hours, 59 minutes</td>
</tr>
<tr>
<td></td>
<td>Lockout user for Amount of time a user account is locked out of the Central Designer application after exceeding the allowed number of login attempts.</td>
<td>30</td>
<td>0 minutes - 23 hours, 59 minutes</td>
</tr>
<tr>
<td></td>
<td>Manually reactivate user When selected, the user is locked out of the Central Designer application after exceeding the allowed number of login attempts, and cannot log back in until an administrator reactivates the user account.</td>
<td>Not selected</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Note</td>
<td>This option takes precedence over the Lockout user for field setting.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session settings section</td>
<td>Inactivity timeout Amount of time in which users can stop working before they are prompted to re-enter their passwords.</td>
<td>20 minutes</td>
<td>15 minutes - 23 hours, 59 minutes</td>
</tr>
<tr>
<td>Note</td>
<td>The Inactivity timeout value must be lower than the User must re-authenticate value.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default value</td>
<td>Acceptable range</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>User must re-authenticate every</td>
<td>The amount of time that can pass before users are prompted to re-enter their passwords, even if they have not stopped working.</td>
<td>4 hours</td>
<td>1 hour - 6 days, 23 hours, 59 minutes</td>
</tr>
</tbody>
</table>
CHAPTER 6
Catalog administration

In this chapter

Checklist—Creating and using keywords and categories ......................................................... 80
Working with a catalog.................................................................................................................. 81
About the Catalog workspace....................................................................................................... 86
Checklist—Creating and using keywords and categories

Use the following checklist to set up the Study Objects and Users catalogs in the Central Designer Administrator application. Catalogs consist of keywords and categories.

Perform the steps in the order in which they are presented. Depending on how your company uses the Central Designer application, you might not need to perform all steps.

For more information about the catalog workflow, see Workflow for categorizing users with categories and keywords (on page 84).

<table>
<thead>
<tr>
<th>Workflow step</th>
<th>Where to get more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>About the catalog workspace (on page 86).</td>
</tr>
<tr>
<td>2</td>
<td>Creating and deleting a keyword (on page 82).</td>
</tr>
<tr>
<td>3</td>
<td>Creating and removing a category (on page 83).</td>
</tr>
<tr>
<td>4</td>
<td>Categorizing a user with keywords and categories (on page 25).</td>
</tr>
<tr>
<td>5</td>
<td>User Guide</td>
</tr>
</tbody>
</table>
Working with a catalog

Searching a catalog for a keyword

You can search for keywords in the Library Object catalog and User catalog.

**Note:** The search in both catalogs is case sensitive. For example, if you type **Designer** in the search field, the search engine does not detect the **designer** keyword.

1. Click the Catalog button.
2. In the Catalog section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.
3. In the **Click here to search or create a new Keyword** field, type a keyword.
   As you type, a real-time search of the list is performed, and the first keyword that matches the text that you type is selected.

**Note:** If you type a keyword that is not in the list, and you want to add it to the list, press Enter.

Searching a catalog for a keyword

You can search for keywords in the Study Objects catalog and Users catalog.

**Note:** The search in both catalogs is case sensitive. For example, if you type **Designer** in the search field, the search engine does not detect the **designer** keyword.

1. Click the Catalog button.
2. In the Catalog section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.
3. In the **Click here to search or create a new Keyword** field, type a keyword.
   As you type, a real-time search of the list is performed, and the first keyword that matches the text that you type is selected.

**Note:** If you type a keyword that is not in the list, and you want to add it to the list, press Enter.
Creating and deleting a keyword

Keyword names must be unique. Keywords are also case sensitive—for example, radiotherapy and Radiotherapy are considered unique keywords.

**Note:** If you delete a keyword that is used to categorize a study object or user, the study object and user are no longer searchable by the keyword.

**Note:** You cannot modify or delete a user keyword.

To create a keyword in a catalog:

1. Click the **Catalog** button.
2. In the **Catalog** section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.
3. In the **Click here to search or create a new Keyword** field, type a keyword, and press **Enter**.
   
   or
   
   Right-click the **Keywords** list, and select **Add**, or press **Ctrl+N**. In the dialog box that appears, type a keyword, and press **Enter**.

   The keyword is added to the list for the selected catalog.

To delete a keyword:

1. Click the **Catalog** button.
2. In the **Catalog** section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.
3. In the **Keywords** list, select a keyword, and press **Delete**.
   
   or
   
   In the **Keywords** list, right-click a keyword, and select **Delete**.

Copying a keyword

You can copy a keyword and then paste it to the Categories tree.

**Note:** When you paste a keyword to the Categories tree, it exists in the Keywords list as a keyword and the Categories tree as a category. When you select the keyword in the Keywords list, all instances of the keyword in the Categories tree are highlighted in bold text.

1. Click the **Catalog** button.
2. In the **Catalog** section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.
3 In the Keywords list, right-click the keyword that you want to copy, and select Copy.

4 In the Categories tree, right-click the category in which you want to create the category, and select Paste.

Creating and removing a category

You create new categories by dragging keywords to the Categories tree. You can also create categories by copying keywords and pasting them in the Categories tree. You can remove a category from the Categories tree at any time.

**Note:** If you delete a category that is used to categorize a study object or user, the category and all child categories below it are deleted. Study objects and users are no longer searchable by the deleted categories.

To create a category:

1 Click the Catalog button.

2 In the Catalog section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.

3 In the Keywords list, select a keyword and drag it to the desired location in the Categories tree.
   - To add the keyword below a specific category in the Categories tree, drag the keyword to that category.
   - To add the keyword to the highest level of the Categories tree, drag the keyword to blank space in the Categories section.

   or

   In the Keywords list, right-click a keyword, and select Copy. In the Categories tree, right-click a category, and select Paste.

To remove a category:

1 Click the Catalog button.

2 In the Catalog section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.

3 In the Categories section, right-click the category that you want to remove, and select Remove, or press Delete.
Cutting, copying, or pasting a category

You can cut, copy, and paste categories that appear in the Categories tree in the Study Objects and Users catalogs.

**Note:** When you cut and copy a category, you also cut or copy all child categories below it.

1. Click the **Catalog** button.
2. In the **Catalog** section, click one of the following links:
   - **Study Objects**—The Study Objects Catalog workspace appears.
   - **Users**—The Users Catalog workspace appears.
3. In the **Categories** tree, right-click a category, and select one of the following options:
   - **Copy** (or press **Ctrl+C**)—Create a copy of the category and all child categories below it.
   - **Cut** (or press **Ctrl+X**)—Cut the category and all child categories below it.
4. Right-click the category below which you want to paste the cut or copied category, and select **Paste**, or press **Ctrl+V**.

Workflow for categorizing users with categories and keywords

An administrator for the Central Designer Administrator application follows these steps to categorize Central Designer users:

1. The administrator selects a user and selects the Categorization tab, where you can view all keywords and categories in the Users catalog.
2. The administrator categorizes users with one or more keywords and categories.

A Central Designer study administrator follows these steps to search for categorized users:

1. The study administrator opens the Users Browser and searches using categories and keywords as search parameters.
   - The search finds only users categorized with the selected parameters.
2. The study administrator adds the users to study or library teams.
In the following example, assume a user is a study architect with .NET experience working in Boston. That user could be categorized with the .NET, Architect, and Boston keywords. If Central Designer users select the .NET, Architect, or Boston (or all three) keywords as search parameters, then the user appears in the search results.

Associate with keywords:

- .NET
- Architect
- Boston
- Data Specialist
- Designer
- Developer
- Dublin
- Geneva
- Location
- London
- PSQL
- Skills
- VB Script
About the Catalog workspace

In the Catalog workspace, you perform catalog administration using keywords and categories. Keywords and categories are used to categorize:

- Users in the Central Designer Administrator application.
- Study objects in the Central Designer application.

Categorizing users and study objects with keywords and categories allows for faster and more efficient searching in the Users Browser and Libraries Browser in the Central Designer application.

- A keyword is an identifier that is associated with users and study objects to facilitate more powerful and efficient searches. A keyword can be system-generated or user-defined. Keywords appear in the Keywords list.
- A category is a hierarchical grouping of keywords. You can create categories only from existing keywords. A category can be automatically generated or manually generated. *Categories appear in the Categories tree.*

The Catalog workspace contains two catalogs:

- **Study Objects catalog**—Create keywords and categories for study objects.
- **Users catalog**—Use system keywords to create categories for users.

Types of keywords and categories

The Study Objects and Users catalogs contain system and user keywords and automatically generated and manually generated categories. The following table describes each keyword and category and tells the location of each in the Central Designer application.

<table>
<thead>
<tr>
<th>Type of keyword or category</th>
<th>Location in Libraries Browser</th>
<th>Location in Users Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System keywords</strong></td>
<td>Keywords tab &gt; System list</td>
<td>Keywords tab &gt; System list</td>
</tr>
<tr>
<td>System keywords are keywords that are installed by default with the Central Designer application or that an administrator creates in the Central Designer Administrator application.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>User keywords</strong></td>
<td>Keywords tab &gt; User list</td>
<td>You cannot categorize users with user keywords.</td>
</tr>
<tr>
<td>User keywords are keywords that a Central Designer user creates. You cannot view keywords that other users create, and other users cannot view your user keywords. Only study objects can be categorized with user keywords.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Automatically generated categories</strong></td>
<td>Categories tab &gt; Automatically Generated tree</td>
<td>Categories tab &gt; Automatically Generated tree</td>
</tr>
<tr>
<td>Automatically generated categories are categories that automatically catalog study objects by auditing information (for example, the study object type, original author, creation date, and library in which the study object was created).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type of keyword or category</td>
<td>Location in Libraries Browser</td>
<td>Location in Users Browser</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Manually generated categories</td>
<td>Categories tab &gt; Manually Generated tree</td>
<td>Categories tab &gt; Manually Generated tree</td>
</tr>
</tbody>
</table>

**Note:** The Libraries Browser and Users Browser are in the Central Designer application.
CHAPTER 7
Server management administration

In this chapter

Working with event log messages for a web farm ................................................................. 90
Working with a web farm and the primary job scheduler .................................................... 92
Working with event log messages for a web farm

**Working with Event Log messages for a web farm**

To view the messages:

1. Select **Server Management**.
2. Under **Server Management**, select **Event Log Messages**.
   
   The Event Log Messages workspace appears.
3. Click **Export**.
   
   A dialog box appears.
4. Select a start date and time and an end date and time.
5. Click **Browse**.
   
   The Save As dialog box appears.
6. Type a file name, browse to a location, and click **Save**.
7. Click **OK**.
   
   After the file is created, a message informs you of the number of messages that it contains.
8. Open and review the file.

**To change the default limit for the number of entries in the log:**

```
Note: Changing the default limit for the number of entries in the log does not affect the Event Log on the application server. This limit applies only to the information that has been collected from all of the application servers and saved in the database.
```

1. Select **Server Management**.
2. Under **Server Management**, select **Event Log Messages**.
   
   The Event Log Messages workspace appears.
3. In **Maximum Rows in Database**, type the number to use as the limit.

**To delete all entries in the log:**

1. Select **Server Management**.
2. Under **Server Management**, select **Event Log Messages**.
   
   The Event Log Messages workspace appears.
3. Click **Purge**.
   
   A dialog box appears.
4. Choose one of the following options:
   - To delete all messages, select **Purge All**.
   - To delete all messages before a specific date, select the date from the **Before Date** drop-down list.
Event Log Messages workspace

If your environment supports a web farm, you work with entries from the Event Log in the Event Log Messages workspace.

Each application server in the web farm contains a separate Event Log. However, all information, warning, and error messages that are related to the Central Designer application are collected in a table in the database. The table contains one row for each entry in the Event Log.

You can request the messages for a range of dates. An XML file that contains log information is created. You can analyze the XML file using an application that views XML information, or you can use an XSLT transfer to read the file in the Microsoft Internet Explorer browser.

The limit for the number of entries in the log is 10,000 by default, but you can configure the number. An Oracle database job runs nightly to delete older records that exceed the limit for the number of entries. The next Oracle database job that runs uses the setting that you provide. Additionally, at any time you can delete all entries in the log or entries that were logged before a specified date.

To open the Event Log Messages workspace:

1. Select Server Management.
Chapter 7  Server management administration

Working with a web farm and the primary job scheduler

Determining and changing the primary job scheduler

To determine the primary job scheduler:

1. Select **Server Management**.
2. Under **Server Management**, select **Job Scheduler**.
   The Job Scheduler workspace appears.
   The primary job scheduler appears in the **Machine name** drop-down list.

To change the primary job scheduler:

1. Select **Server Management**.
2. Under **Server Management**, select **Job Scheduler**.
   The Job Scheduler workspace appears.
3. In the **Primary Job Scheduler** section, **Machine name** drop-down list, select the computer on which to run the Job Scheduler service. If the name of a server in the web farm does not appear (for example, if you renamed it), click **Other**, and type the name of the computer.
   
   **Note:** If you rename a computer after installing the Central Designer server application on it, the name of the computer no longer appears in the drop-down list. If you remove a server from the web farm, its name still appears in the list.

4. Click **Save**.
   After the Job Scheduler service that was the primary finishes processing the requests that were in its queue, it becomes idle. The new primary job scheduler processes all new requests.

Viewing the servers that are in the web farm

1. Select **Server Management**.
2. Under **Server Management**, select **Job Scheduler**.
   The Job Scheduler workspace appears.
   The Machine name drop-down list includes all servers in the web farm.

   **Note:** If you rename a computer after installing the Central Designer server application on it, the name of the computer no longer appears in the drop-down list. If you remove a server from the web farm, its name still appears in the list.
Removing a server from a web farm

To remove the server with the primary Job Scheduler from a web farm:

1. Change the primary Job Scheduler (on page 92).
2. Wait until the Job Scheduler service becomes idle, indicating that it is finished processing requests.
3. Follow your organization's regular procedure for removing a server from a web farm.

To remove a server that does not have the primary Job Scheduler:

- Follow your organization's regular procedure for removing a server from a web farm.

Checking whether the primary Job Scheduler service is running

1. Select Server Management.
   The Job Scheduler workspace appears.
   A graphic with text appears to the right of the Machine names drop-down list, indicating whether the service is running.

Viewing job properties and cancelling a job in the Job Scheduler queue

Examples of jobs include validation and file import as well as scheduled jobs.

**Note:** You cannot cancel a scheduled job.

1. Click the Server Management button.
2. Under Server Management, click Job Scheduler.
   The Job Scheduler Manager workspace appears.
   All jobs appear in the grid.
3. If a job does not appear in the grid, in the toolbar above the grid, click Refresh.
4. To view details about a job:
   a. In the grid, select the job.
   b. In the toolbar above the grid, click Properties.
5. To cancel a job:
   a. In the grid, select one or more unscheduled jobs.

**Note:** The job name in the Job Scheduler workspace corresponds to the job name in the Jobs Browser. Use the job name to identify a specific job to stop in the Central Designer Administrator application.
b In the toolbar above the grid, select **Stop Job**.
   You are prompted to confirm.

c Click **Yes** or, if you selected multiple jobs, **Yes to All**.

**Job Scheduler workspace**

In the Job Scheduler workspace, you perform the following tasks:

- Check whether an instance of the Job Scheduler service is running.
- View and cancel jobs in the job scheduler queue.
- Determine and change the primary job scheduler.
- View job properties.

**To open the Job Scheduler workspace:**

1 Click the **Server Management** button.
2 Under **Server Management**, click **Job Scheduler**.
In this chapter

Keyboard shortcuts .............................................................................................................................. 96
Status toolbar—Option descriptions ................................................................................................. 99
# Keyboard shortcuts

## Keyboard shortcuts for opening menus

The following shortcuts are always available.

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F</td>
<td>Open the File menu.</td>
</tr>
<tr>
<td>Alt+E</td>
<td>Open the Edit menu.</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Open the View menu.</td>
</tr>
<tr>
<td>Alt+A</td>
<td>Open the Actions menu.</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Open the Help menu.</td>
</tr>
</tbody>
</table>

## Keyboard shortcuts for the Users workspace

The following shortcuts are available when the Users workspace appears.

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+D</td>
<td>Deactivate the selected user.</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Create a new user.</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Terminate the selected user.</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Activate the selected user.</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Change the password of the selected user.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy the selected user.</td>
</tr>
</tbody>
</table>

**Personal Info tab**

The following shortcuts are available only when the Personal Info tab is selected.

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+T</td>
<td>Select the Title field.</td>
</tr>
<tr>
<td>Alt+N</td>
<td>Select the Position field.</td>
</tr>
<tr>
<td>Alt+S</td>
<td>Select the First Name field.</td>
</tr>
<tr>
<td>Alt+L</td>
<td>Select the Last Name field.</td>
</tr>
<tr>
<td>Alt+M</td>
<td>Select the Email field.</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Select the Company field.</td>
</tr>
<tr>
<td>Alt+R</td>
<td>Select the Department field.</td>
</tr>
<tr>
<td>Alt+D</td>
<td>Select the Address field.</td>
</tr>
<tr>
<td>Alt+I</td>
<td>Select the City field.</td>
</tr>
<tr>
<td>Alt+P</td>
<td>Select the Postal Code field.</td>
</tr>
</tbody>
</table>


Keyboard shortcuts for the Roles workspace

The following shortcuts are available when the Roles workspace appears.

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>Create a new role.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy the selected role.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected role.</td>
</tr>
</tbody>
</table>

Keyboard shortcuts for the Custom Properties workspace

The following shortcuts are available when the System Config workspace appears and the Custom Properties link is selected.

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Remove the selected custom property.</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>If a study object is selected—Create a new grouping.</td>
</tr>
<tr>
<td></td>
<td>If a grouping is selected—Create a new custom property.</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>If a grouping is selected—Rename the selected grouping.</td>
</tr>
<tr>
<td></td>
<td>If a custom property is selected—Rename the selected custom property.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>If a grouping is selected—Copy the selected grouping.</td>
</tr>
<tr>
<td></td>
<td>If a custom property is selected—Copy the selected custom property.</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>If a grouping is selected—Cut the selected grouping.</td>
</tr>
<tr>
<td></td>
<td>If a custom property is selected—Cut the selected custom property.</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>If a grouping is selected—Paste the selected grouping.</td>
</tr>
<tr>
<td></td>
<td>If a custom property is selected—Paste the selected custom property.</td>
</tr>
</tbody>
</table>
Keyboard shortcuts for the Catalog workspace

The following shortcuts are available when the Catalog workspace is visible.

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>Create a new keyword.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected keyword or category.</td>
</tr>
</tbody>
</table>
| Ctrl+C            | - If a keyword is selected—Copy the selected keyword.  
                   - If a category is selected—Copy the selected category. |
| Ctrl+V            | Paste the selected category. |
| Ctrl+X            | Cut the selected category. |
### Status toolbar—Option descriptions

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Gray circle icon](image) or ![Blue circle icon](image) | ![Gray circle icon](image)—The server is not processing information, and you can work.  
![Blue circle icon](image)—The server is processing information. Wait until the process completes before performing another activity. |

You are logged on, and the application is connected to the application server.
APPENDIX A
Rights descriptions

In this appendix

Roles workspace—Right descriptions ................................................................. 102
Application roles—Right descriptions ............................................................... 103
Library roles—Right descriptions ...................................................................... 110
Study roles—Right descriptions ........................................................................ 113
Roles workspace—Right descriptions

When you create a role, you choose the scope of the role. A role can have a library, study, or application scope. Each scope has a set of rights that you can grant to the role.

- Roles with the library scope become library teams in the Central Designer application.
- Roles with the study scope become study teams in the Central Designer application.

Users are granted rights associated with roles in the following manner:

- **Application roles**
  A user assigned to an application role is granted all of the rights that are associated with the role, without restrictions. For example, a user who has the right to create users can always create users.

  For more information, see *Application roles—Right descriptions* (on page 103).

- **Library roles**
  A user assigned to a library role is granted the rights associated with the role only in libraries where that user is also a member of the library team. For example, if a user is assigned to the Librarian library role in the Central Designer Administrator application, the user must be a member of the Librarian library team for a library (in the Central Designer application) to work in the library.

  For more information, see *Library roles—Right descriptions* (on page 110).

- **Study roles**
  A user assigned to a study role is granted the rights associated with the role only in studies where the user is also a member of the study team. For example, if a user is assigned to the Rule Creation study role in the Central Designer Administrator application, the user must also be a member of the Rule Creation study team for a study to create rules in the study.

  For more information, see *Study roles—Right descriptions* (on page 113).

**Note:** You assign users to roles in the Central Designer Administrator application and to study and library teams in the Central Designer application.
Application roles—Right descriptions

The rights for application roles are related to activities in the Central Designer and Central Designer Administrator applications. Users do not need to be assigned to any teams to have rights.

Application Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log on to the Central Designer software</td>
<td>Log on to the Central Designer application.</td>
</tr>
<tr>
<td>Log on to the Central Designer Administrator software</td>
<td>Log on to the Central Designer Administrator application.</td>
</tr>
</tbody>
</table>
| Perform all activities in all studies and libraries (super-user) | • Log on to the Central Designer and Central Designer Administrator applications.  
 • Use all functionality in the Central Designer and Central Designer Administrator applications, regardless of team assignment.  
 • Perform other administrative tasks, such as close a task opened by someone else and unlock the locks held by other users. |

Archive Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import archive</td>
<td>Import an archived study, study project, or library project.</td>
</tr>
<tr>
<td>Archive library project</td>
<td>Archive a library project.</td>
</tr>
<tr>
<td>Archive studies and study projects</td>
<td>Archive a study or study project.</td>
</tr>
</tbody>
</table>

Catalog Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create keywords and categories in Users Catalog</td>
<td>Create keywords and categories in the Users catalog.</td>
</tr>
<tr>
<td>View Users catalog</td>
<td>View the Users catalog.</td>
</tr>
<tr>
<td>Delete keywords and categories in Users catalog</td>
<td>Delete keywords and categories in the Users catalog.</td>
</tr>
</tbody>
</table>
### Appendix A Rights descriptions

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create keywords and categories in Study Objects catalog</td>
<td>Create keywords and categories in the Study Objects catalog.</td>
</tr>
<tr>
<td>View Study Objects catalog</td>
<td>View the Study Objects catalog.</td>
</tr>
<tr>
<td>Delete keywords and categories in Study Objects catalog</td>
<td>Delete keywords and categories in the Study Objects catalog.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

### Coding Dictionaries Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify coding dictionary types</td>
<td>Create and modify coding dictionary types.</td>
</tr>
<tr>
<td>View coding dictionary types</td>
<td>View coding dictionary types.</td>
</tr>
<tr>
<td>View and modify coding dictionary metadata items</td>
<td>View and modify coding dictionary metadata items.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

### Collaboration Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify collaboration note types</td>
<td>Create and modify collaboration note types.</td>
</tr>
<tr>
<td>View collaboration note types</td>
<td>View information about collaboration note types.</td>
</tr>
<tr>
<td>Delete collaboration note types</td>
<td>Delete collaboration note types.</td>
</tr>
<tr>
<td>Create and modify task types</td>
<td>Create and modify task types.</td>
</tr>
<tr>
<td>View task types</td>
<td>View information about task types.</td>
</tr>
<tr>
<td>Delete task types</td>
<td>Delete task types.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.
## Custom Properties Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify custom properties</td>
<td>Create and modify custom properties and groupings.</td>
</tr>
<tr>
<td>View custom properties</td>
<td>View information about custom properties.</td>
</tr>
<tr>
<td>Delete custom properties</td>
<td>Delete custom properties and groupings.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

## Language Library Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify language library</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>View language library</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>

## Library Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer library teams</td>
<td>Create, modify, and delete library teams.</td>
</tr>
<tr>
<td>Create Libraries</td>
<td>Create library projects and libraries.</td>
</tr>
<tr>
<td>Modify library properties</td>
<td>• Enable and disable libraries.</td>
</tr>
<tr>
<td></td>
<td>• Modify library projects and libraries.</td>
</tr>
<tr>
<td></td>
<td>• Modify library properties in the Library Editor &gt; Administration tab and the Properties Browser.</td>
</tr>
<tr>
<td>Delete libraries</td>
<td>Delete a library project and all of its study objects.</td>
</tr>
</tbody>
</table>

## Locales Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add locales</td>
<td>Add locales.</td>
</tr>
<tr>
<td>View locales</td>
<td>View information about locales.</td>
</tr>
<tr>
<td>Remove locale</td>
<td>Remove locales.</td>
</tr>
</tbody>
</table>
### Reports Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the list of available</td>
<td>Import a new reports file into the database.</td>
</tr>
<tr>
<td>reports in the system</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

### Role Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify roles</td>
<td>Create and modify roles in the Central Designer Administrator application.</td>
</tr>
<tr>
<td>View roles</td>
<td>View information about roles in the Central Designer Administrator application.</td>
</tr>
<tr>
<td>Delete roles</td>
<td>Delete roles in the Central Designer Administrator application.</td>
</tr>
<tr>
<td>Change users in roles</td>
<td>Assign users to roles.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

### Search

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for users</td>
<td>Search for users in the Users Browser.</td>
</tr>
<tr>
<td>Save and modify user searches</td>
<td>Save and modify Users Browser searches.</td>
</tr>
<tr>
<td>Delete user searches</td>
<td>Delete Users Browser searches.</td>
</tr>
<tr>
<td>Search for study objects</td>
<td>Search for study objects in the Libraries Browser.</td>
</tr>
<tr>
<td>Save and modify study object</td>
<td>Save and modify Libraries Browser searches.</td>
</tr>
<tr>
<td>Delete study object searches</td>
<td>Delete Libraries Browser searches.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.
Security Settings Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View security settings</td>
<td>View the Security workspace, which is available in the System Config view.</td>
</tr>
<tr>
<td>Modify security settings</td>
<td>Modify the options in the Security workspace.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

Sponsors Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify sponsors</td>
<td>Create and modify sponsors in the Sponsors workspace in the Central Designer Administrator application.</td>
</tr>
<tr>
<td>Remove sponsors</td>
<td>Delete sponsors from the Sponsors workspace in the Central Designer Administrator application.</td>
</tr>
<tr>
<td>View sponsors</td>
<td>View the list of sponsors in the Sponsors workspace in the Central Designer Administrator application.</td>
</tr>
</tbody>
</table>

Study Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer study teams</td>
<td>Create, modify, and delete study teams.</td>
</tr>
<tr>
<td>Create studies</td>
<td>Create study projects and studies.</td>
</tr>
<tr>
<td>Modify study properties</td>
<td>- Modify study projects and studies.</td>
</tr>
<tr>
<td></td>
<td>- Modify study properties in the Study Editor &gt; Administration tab and the Properties Browser.</td>
</tr>
<tr>
<td>Delete studies</td>
<td>Delete a study or study project and all of its study objects.</td>
</tr>
<tr>
<td>Create study project templates</td>
<td>- Mark study projects as templates.</td>
</tr>
<tr>
<td></td>
<td>- View study project templates in the Open Project dialog box.</td>
</tr>
</tbody>
</table>
## Units Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the list of available units in the system</td>
<td>Import a new units file into the database.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

## User Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify users</td>
<td>Create and modify users.</td>
</tr>
<tr>
<td>View users</td>
<td>View information about users.</td>
</tr>
<tr>
<td>Activate users</td>
<td>Activate users.</td>
</tr>
<tr>
<td>Terminate and deactivate users</td>
<td>Deactivate and terminate users.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.

## Verbatim Types Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify verbatim types</td>
<td>Create and modify verbatim types.</td>
</tr>
<tr>
<td>View verbatim types</td>
<td>View verbatim types.</td>
</tr>
<tr>
<td>Remove verbatim types</td>
<td>Remove verbatim types.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.
### Web Farm Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the machine on which the Job Scheduler will be processing tasks</td>
<td>Specify the primary job scheduler.</td>
</tr>
<tr>
<td>View, export and delete event log messages stored in database</td>
<td>View, export, and delete event log messages.</td>
</tr>
</tbody>
</table>

**Note:** These rights provide access to functionality in the Central Designer Administrator application.
Library roles—Right descriptions

The rights for a library role are granted to Central Designer users only when users are assigned to the role as well as the corresponding library team.

Library Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify library Administration tab</td>
<td>• Enable and disable libraries.</td>
</tr>
<tr>
<td></td>
<td>• Modify library properties in the Library Editor &gt; Administration tab and the Properties Browser.</td>
</tr>
<tr>
<td>Publish library objects</td>
<td>Publish and unpublish study objects.</td>
</tr>
<tr>
<td>Perform team administration</td>
<td>Modify library teams.</td>
</tr>
<tr>
<td>Create templates and types</td>
<td>Create templates and types.</td>
</tr>
</tbody>
</table>

Library Collaboration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify collaboration notes created by other users</td>
<td>Modify collaboration notes created by other users.</td>
</tr>
<tr>
<td>Create and assign tasks</td>
<td>Create, modify, and assign tasks.</td>
</tr>
</tbody>
</table>

Note: All users can view the Collaboration Notes Browser and Tasks Browser. All users can view tasks and collaboration notes and can create collaboration notes. Users can modify and delete collaboration notes and tasks that they create.

Library Design

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define and modify study workflow</td>
<td>• Create, modify, and delete study workflows, study elements, and study events.</td>
</tr>
<tr>
<td></td>
<td>• Modify properties of study elements and study events in the Properties Browser.</td>
</tr>
<tr>
<td>Create InForm forms</td>
<td>• Mark InForm forms as templates.</td>
</tr>
<tr>
<td></td>
<td>• Create InForm form placeholders (but not design InForm forms or add items).</td>
</tr>
<tr>
<td></td>
<td>• Delete InForm forms.</td>
</tr>
</tbody>
</table>
| Copy and link study objects from libraries | • Copy study objects from a library to the library in which you are working.  
• Copy study objects from a study to the library in which you are working. |
| Define, modify and delete Review States | • Create, modify, delete, lock, and protect InForm review states. |
| Design forms, Items, and codelists | • Create sections, items, codelists, and codelist items.  
• Design and modify forms, sections, items, codelists, and codelist items and their properties in the Properties Browser.  
• Modify study events in the Study Event Editor > General tab. |
| Protect study objects in libraries | • Protect libraries and library study objects. |
| Unprotect study objects in libraries | • Unprotect libraries and library study objects. |

## Library Help

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify study help</td>
<td>Modify study object Help information.</td>
</tr>
</tbody>
</table>

## Library Import Export

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import library</td>
<td>Import study objects into libraries.</td>
</tr>
<tr>
<td>Export library</td>
<td>Export study objects from libraries.</td>
</tr>
</tbody>
</table>

## Library Import Export Translations

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export library translations</td>
<td>Export text strings to be translated.</td>
</tr>
<tr>
<td>Import library translations</td>
<td>Import translated text strings.</td>
</tr>
</tbody>
</table>

## Library Jobs Browser

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Job Log records</td>
<td>Use the Jobs Browser and view job results in the Jobs Browser.</td>
</tr>
</tbody>
</table>
## Library Logical Schemas

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify logical schema objects</td>
<td>• View, create, and modify logical schemas, data sets, and data series.</td>
</tr>
<tr>
<td></td>
<td>• Modify logical schema properties in the Properties Browser.</td>
</tr>
<tr>
<td>Create and modify logical schema associations</td>
<td>• Add items to data series.</td>
</tr>
<tr>
<td></td>
<td>• On the Data Series Summary tab in the Form Editor and Study Event Editor, modify when items on specific forms and study events are mapped to a data series.</td>
</tr>
</tbody>
</table>

## Library Rule Design

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import user-defined functions</td>
<td>Import functions.</td>
</tr>
<tr>
<td>Define and modify constants</td>
<td>Create and modify constants.</td>
</tr>
<tr>
<td>Define and modify InForm rule templates</td>
<td>Create and modify InForm rule templates for data-entry rules.</td>
</tr>
<tr>
<td>Define and modify InForm data-entry rules</td>
<td>Create and modify InForm data-entry rules.</td>
</tr>
</tbody>
</table>

## Library Translation

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translate library components</td>
<td>Translate study objects and components.</td>
</tr>
</tbody>
</table>
Study roles—Right descriptions

The rights for a study role are granted to Central Designer users only when users are assigned to the role as well as the corresponding study team.

Study Administration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Study Editor &gt; Administration tab</td>
<td>Modify study properties in the Study Editor &gt; Administration tab and the Properties Browser.</td>
</tr>
<tr>
<td>Modify study goals and references</td>
<td>Modify information in the Study Editor &gt; References tab.</td>
</tr>
<tr>
<td>Perform team administration</td>
<td>Modify study teams.</td>
</tr>
<tr>
<td>Create study project templates</td>
<td>Create templates for study projects.</td>
</tr>
</tbody>
</table>

Study Annotated Studybook

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Annotated Study Books</td>
<td>• Create annotated study books.</td>
</tr>
<tr>
<td></td>
<td>• Edit annotated study book options.</td>
</tr>
</tbody>
</table>

Study Collaboration

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify collaboration notes created by other users</td>
<td>Modify collaboration notes created by other users.</td>
</tr>
<tr>
<td>Create and assign tasks</td>
<td>Create, modify, and assign tasks.</td>
</tr>
</tbody>
</table>

Note: All users can view the Collaboration Notes Browser and Tasks Browser. All users can view tasks and collaboration notes and can create collaboration notes. Users can modify and delete collaboration notes and tasks that they create.
# Study Deployment

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish and delete baselines</td>
<td>Publish and delete baselines.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can validate a study if you have the Designer Login right (available for application roles in the Application Administration grouping).</td>
</tr>
<tr>
<td>Create and manage deployment</td>
<td>Create and manage study deployment packages.</td>
</tr>
<tr>
<td>packages</td>
<td></td>
</tr>
<tr>
<td>Save deployment packages</td>
<td>Save deployment packages.</td>
</tr>
</tbody>
</table>

# Study Design

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define or modify study workflow</td>
<td>• Create, modify, and delete study workflows, study elements, and study events.</td>
</tr>
<tr>
<td></td>
<td>• Modify properties of study elements and study events in the Properties Browser.</td>
</tr>
<tr>
<td></td>
<td>• Modify study designs.</td>
</tr>
<tr>
<td></td>
<td>• Modify the title and short title of the study's common visit.</td>
</tr>
<tr>
<td>Create InForm forms</td>
<td>• Create InForm form placeholders (but not design InForm forms or add items).</td>
</tr>
<tr>
<td></td>
<td>• Delete InForm forms.</td>
</tr>
<tr>
<td>Copy study objects from libraries</td>
<td>• Copy study objects from a library to the study.</td>
</tr>
<tr>
<td>Define, modify and delete Review States</td>
<td>• Create, modify, delete, lock, and protect InForm review states.</td>
</tr>
<tr>
<td>Design forms, items, and codelists</td>
<td>• Create sections, items, codelists, and codelist items.</td>
</tr>
<tr>
<td></td>
<td>• Design and modify forms, sections, items, codelists, and codelist items and their properties in the Properties Browser.</td>
</tr>
<tr>
<td></td>
<td>• Modify study events in the Study Event Editor &gt; General tab.</td>
</tr>
<tr>
<td>Protect study or study object</td>
<td>• Protect studies and study objects.</td>
</tr>
<tr>
<td>Unprotect study or study object</td>
<td>• Unprotect studies and study objects.</td>
</tr>
<tr>
<td>Unprotect study objects from libraries</td>
<td>• Unprotect study objects that came from libraries.</td>
</tr>
</tbody>
</table>
### Study Help

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify study help</td>
<td>Modify study object Help information.</td>
</tr>
</tbody>
</table>

### Study Import Export

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Study</td>
<td>Import study objects into studies.</td>
</tr>
<tr>
<td>Export Study</td>
<td>Export study objects from studies.</td>
</tr>
</tbody>
</table>

### Study Import Export Translations

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export study translations</td>
<td>Export text strings to be translated.</td>
</tr>
<tr>
<td>Import study translations</td>
<td>Import translated text strings.</td>
</tr>
</tbody>
</table>

### Study Jobs Browser

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Job Log records</td>
<td>Use the Jobs Browser and view job results in the Jobs Browser.</td>
</tr>
</tbody>
</table>

### Study Logical Schema

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify logical schema objects</td>
<td>• View, create, and modify logical schemas, data sets, and data series.</td>
</tr>
<tr>
<td></td>
<td>• Modify logical schema properties in the Properties Browser.</td>
</tr>
<tr>
<td>Create and modify logical schema associations</td>
<td>• Add items to data series.</td>
</tr>
<tr>
<td></td>
<td>• On the Data Series Summary tab in the Form Editor and Study Event Editor, modify when items on specific forms and study events are mapped to a data series.</td>
</tr>
</tbody>
</table>
Study Rule Design

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import user-defined functions</td>
<td>Import functions.</td>
</tr>
<tr>
<td>Define and modify constants</td>
<td>Create and modify constants.</td>
</tr>
<tr>
<td>Define and modify InForm rule templates</td>
<td>Create and modify InForm rule templates for data-entry rules.</td>
</tr>
<tr>
<td>Define and modify InForm data-entry rules</td>
<td>Create and modify InForm data-entry rules.</td>
</tr>
</tbody>
</table>

Study Translation

<table>
<thead>
<tr>
<th>Right</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translate study components</td>
<td>Translate study objects and components.</td>
</tr>
</tbody>
</table>
APPENDIX B
Adding units and conversion calculations

In this appendix

About units and conversion calculations .................................................................118
Unit XML definition .................................................................................................119
Conversion calculation XML definition .................................................................120
Editing the units file ...............................................................................................121
Units defined in the units file ..................................................................................122
Conversion calculations defined in the units file ...................................................123
Supported locales and their abbreviations ..............................................................124
About units and conversion calculations

When you create integer or float items, you can specify the base unit and one or more conversion units in which users can enter data. The available units and their conversion calculations are stored in the database. To specify additional units and conversion calculations or to provide locale-specific abbreviations, you must export the units file using the Central Designer Administrator application, edit it, and import the file using the Central Designer Administrator application.

After you update and save the file, the next time a user logs on to the Central Designer application, the new unit definitions are available.
Unit XML definition

The definition of a unit is in the following format:

```xml
<Unit Name="name">
  <ConversionMap>name</ConversionMap>
  <Locale Name="name">
    <DisplayString>string</DisplayString>
    <DisplaySymbol>string</DisplaySymbol>
  </Locale>
</Unit>
```

<table>
<thead>
<tr>
<th>XML object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>Definition of the unit. A Unit object includes one or more Locale objects.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Locale-independent name for the unit. Use this name as the value of the From or To attribute in the definitions of conversion calculations for this unit.</td>
</tr>
<tr>
<td><strong>ConversionMap</strong></td>
<td>Name of the conversion definition. Use the value of the Name attribute of the applicable UnitConversionMap object. For more information, see <em>Conversion calculation XML definition</em> (on page 120).</td>
</tr>
<tr>
<td><strong>Locale</strong></td>
<td>Definition of the locale. A Locale object includes a DisplayString and a DisplaySymbol definition.</td>
</tr>
<tr>
<td><strong>Locale Name</strong></td>
<td>International standard locale name, in the format xx-XX. For more information, see <em>Supported locales and their abbreviations</em> (on page 124).</td>
</tr>
<tr>
<td><strong>DisplayString</strong></td>
<td>Display string for the unit in the specified locale.</td>
</tr>
<tr>
<td><strong>DisplaySymbol</strong></td>
<td>Symbol for the unit in the specified locale. This symbol is displayed in the Item Editor for item types that allow units and in the Layout tab.</td>
</tr>
</tbody>
</table>

**XML example**

```xml
[Unit Name="in">
  <ConversionMap>Length</ConversionMap>
  <Locale Name="en-US">
    <DisplayString>Inches</DisplayString>
    <DisplaySymbol>in</DisplaySymbol>
  </Locale>
</Unit>
```
Conversion calculation XML definition

The definition for a conversion calculation is in the following format:

```xml
<UnitConversionMap Name="name" Classification="name">
  <UnitConversion From="name" To="name">{value} formula</UnitConversion>
</UnitConversionMap>
```

<table>
<thead>
<tr>
<th>XML object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UnitConversionMap</td>
<td>Definition of the type of measurement represented by the unit. Each UnitConversionMap object can include multiple UnitConversion definitions. The UnitConversionMap object has the following attributes:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name</strong>—Name of the UnitConversionMap object. This name is the same as the ConversionMap name in the definition each unit included in a conversion calculation definition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Classification</strong>—Classification of the UnitConversionMap object. This name matches the corresponding classification type in the MedML definition of a unit in the InForm application.</td>
</tr>
<tr>
<td>UnitConversion</td>
<td>Formula used to convert one unit value to another. The UnitConversion object has the following attributes:</td>
</tr>
<tr>
<td></td>
<td>• <strong>From</strong>—Name attribute of the Unit object from which to make the conversion.</td>
</tr>
<tr>
<td></td>
<td>• <strong>To</strong>—Name attribute of the Unit object to which to make the conversion.</td>
</tr>
</tbody>
</table>

**XML example**

```xml
<UnitConversionMap Name="Temp" Classification="Temperature">
  <UnitConversion From="Cent" To="Fahren">({value}*9/5)+32</UnitConversion>
  <UnitConversion From="Fahren" To="Cent">({value}-32)*5/9</UnitConversion>
</UnitConversionMap>
<UnitConversionMap Name="Weight" Classification="Weight">
  <UnitConversion From="Pounds" To="Kilogram">{value}*0.454</UnitConversion>
  <UnitConversion From="Kilogram" To="Pounds">{value}*2.205</UnitConversion>
  <UnitConversion From="Ounce" To="Gram">{value}*28.35</UnitConversion>
  <UnitConversion From="Gram" To="Ounce">{value}/28.35</UnitConversion>
</UnitConversionMap>
```
Editing the units file

The available units and their conversion calculations are stored in the database. To specify additional units and conversion calculations or to provide locale-specific abbreviations, you must export the units file using the Central Designer Administrator application, edit it, and import the file using the Central Designer Administrator application.

If you edit the units file:

- Create a backup copy of the file before making any changes.
- Oracle recommends adding to the file, rather than deleting or changing existing entries.

<table>
<thead>
<tr>
<th>To make this type of change</th>
<th>Add these objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a unit.</td>
<td>Unit, including a ConversionMap object and one or more Locale objects.</td>
</tr>
<tr>
<td>Add a locale to an existing unit.</td>
<td>Locale, including a DisplayString and DisplaySymbol object.</td>
</tr>
<tr>
<td>Add a conversion calculation for a unit.</td>
<td>UnitConversion. If adding a conversion calculation to a unit that represents a type of measurement not already included in the file, add a UnitConversionMap object for that type of measurement.</td>
</tr>
</tbody>
</table>
# Units defined in the units file

Units are defined in Unit objects.

<table>
<thead>
<tr>
<th>Unit type</th>
<th>Unit Name attribute</th>
<th>DisplaySymbol value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beats per Minute</td>
<td>BPM</td>
<td>bpm</td>
</tr>
<tr>
<td>Breaths per Minute</td>
<td>BreathsPerMinute</td>
<td>BM</td>
</tr>
<tr>
<td>Centigrade</td>
<td>Cent</td>
<td>C</td>
</tr>
<tr>
<td>Centimeters</td>
<td>cm</td>
<td>cm</td>
</tr>
<tr>
<td>Fahrenheit</td>
<td>Fahren</td>
<td>F</td>
</tr>
<tr>
<td>Feet</td>
<td>foot</td>
<td>ft</td>
</tr>
<tr>
<td>Grams</td>
<td>Gram</td>
<td>g</td>
</tr>
<tr>
<td>Inches</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>Kilograms</td>
<td>Kilogram</td>
<td>kg</td>
</tr>
<tr>
<td>Pounds</td>
<td>Pounds</td>
<td>lbs</td>
</tr>
<tr>
<td>Meters</td>
<td>meter</td>
<td>m</td>
</tr>
<tr>
<td>Millimeters</td>
<td>mm</td>
<td>mm</td>
</tr>
<tr>
<td>Milliseconds</td>
<td>msec</td>
<td>msec</td>
</tr>
<tr>
<td>Ounces</td>
<td>Ounce</td>
<td>oz</td>
</tr>
<tr>
<td>Seconds</td>
<td>seconds</td>
<td>sec</td>
</tr>
</tbody>
</table>
Conversion calculations defined in the units file

Conversion calculations are defined in UnitConversion objects, which are child objects of the UnitConversionMap object. From and To attributes of the UnitConversion object match the Name attribute of the Unit object.

<table>
<thead>
<tr>
<th>UnitConversion From attribute</th>
<th>UnitConversion To attribute</th>
<th>UnitConversion value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length conversion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>in</td>
<td>cm</td>
<td>(value) * 2.54</td>
</tr>
<tr>
<td>in</td>
<td>meter</td>
<td>(value) * 0.0254</td>
</tr>
<tr>
<td>in</td>
<td>km</td>
<td>(value) * 2.54 / 100000</td>
</tr>
<tr>
<td>in</td>
<td>mm</td>
<td>(value) * 25.4</td>
</tr>
<tr>
<td>in</td>
<td>foot</td>
<td>(value) / 12</td>
</tr>
<tr>
<td>foot</td>
<td>in</td>
<td>(value) * 12</td>
</tr>
<tr>
<td>cm</td>
<td>in</td>
<td>(value) / 2.54</td>
</tr>
<tr>
<td>cm</td>
<td>meter</td>
<td>(value) / 100</td>
</tr>
<tr>
<td>cm</td>
<td>km</td>
<td>(value) / 100000</td>
</tr>
<tr>
<td>cm</td>
<td>mm</td>
<td>(value) * 10</td>
</tr>
<tr>
<td>cm</td>
<td>foot</td>
<td>(value) / 2.54 / 12</td>
</tr>
<tr>
<td>foot</td>
<td>meter</td>
<td>(value) * .3048</td>
</tr>
<tr>
<td>meter</td>
<td>foot</td>
<td>(value) * 3.2808</td>
</tr>
<tr>
<td>mm</td>
<td>cm</td>
<td>(value) / 10</td>
</tr>
<tr>
<td>mm</td>
<td>in</td>
<td>(value) / 25.4</td>
</tr>
<tr>
<td>Temperature conversions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cent</td>
<td>Fahrenheit</td>
<td>(value) * 9/5 + 32</td>
</tr>
<tr>
<td>Fahrenheit</td>
<td>Cent</td>
<td>(value) - 32 * 5 / 9</td>
</tr>
<tr>
<td>Weight conversions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pounds</td>
<td>Kilogram</td>
<td>(value) * 0.454</td>
</tr>
<tr>
<td>Kilogram</td>
<td>Pounds</td>
<td>(value) * 2.205</td>
</tr>
<tr>
<td>Ounce</td>
<td>Gram</td>
<td>(value) * 28.35</td>
</tr>
<tr>
<td>Gram</td>
<td>Ounce</td>
<td>(value) / 28.35</td>
</tr>
</tbody>
</table>
## Supported locales and their abbreviations

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Afrikaans (South Africa)</td>
<td>af-ZA</td>
<td>Finnish (Finland)</td>
<td>fi-FI</td>
<td>Russian (Russia)</td>
<td>ru-RU</td>
</tr>
<tr>
<td>Albanian (Albania)</td>
<td>sq-AL</td>
<td>French (Belgium)</td>
<td>fr-BE</td>
<td>Sami, Inari (Finland)</td>
<td>smn-FI</td>
</tr>
<tr>
<td>Arabic (Algeria)</td>
<td>ar-DZ</td>
<td>French (Canada)</td>
<td>fr-CA</td>
<td>Sami, Lule (Norway)</td>
<td>smj-NO</td>
</tr>
<tr>
<td>Arabic (Bahrain)</td>
<td>ar-BH</td>
<td>French (France)</td>
<td>fr-FR</td>
<td>Sami, Lule (Sweden)</td>
<td>smj-SE</td>
</tr>
<tr>
<td>Arabic (Egypt)</td>
<td>ar-EG</td>
<td>French (Luxembourg)</td>
<td>fr-LU</td>
<td>Sami, Northern (Finland)</td>
<td>se-FI</td>
</tr>
<tr>
<td>Arabic (Iraq)</td>
<td>ar-IQ</td>
<td>French (Principality of Monaco)</td>
<td>fr-MC</td>
<td>Sami, Northern (Norway)</td>
<td>se-NO</td>
</tr>
<tr>
<td>Arabic (Jordan)</td>
<td>ar-JO</td>
<td>French (Switzerland)</td>
<td>fr-CH</td>
<td>Sami, Northern (Sweden)</td>
<td>se-SE</td>
</tr>
<tr>
<td>Arabic (Kuwait)</td>
<td>ar-KW</td>
<td>Frisian (Netherlands)</td>
<td>fy-NL</td>
<td>Sami, Skolt (Finland)</td>
<td>sms-FI</td>
</tr>
<tr>
<td>Arabic (Lebanon)</td>
<td>ar-LB</td>
<td>Galician (Galicia)</td>
<td>gl-ES</td>
<td>Sami, Southern (Norway)</td>
<td>sma-NO</td>
</tr>
<tr>
<td>Arabic (Libya)</td>
<td>ar-LY</td>
<td>Georgian (Georgia)</td>
<td>ka-GE</td>
<td>Sami, Southern (Sweden)</td>
<td>sma-SE</td>
</tr>
<tr>
<td>Arabic (Morocco)</td>
<td>ar-MA</td>
<td>German (Austria)</td>
<td>de-AT</td>
<td>Sanskrit (India)</td>
<td>sa-IN</td>
</tr>
<tr>
<td>Arabic (Oman)</td>
<td>ar-OM</td>
<td>German (Germany)</td>
<td>de-DE</td>
<td>Serbian (Cyrillic, Bosnia and Herzegovina)</td>
<td>sr-Cyrl-BA</td>
</tr>
<tr>
<td>Arabic (Qatar)</td>
<td>ar-QA</td>
<td>German (Liechtenstein)</td>
<td>de-LI</td>
<td>Serbian (Cyrillic, Serbia)</td>
<td>sr-Cyrl-CS</td>
</tr>
<tr>
<td>Arabic (Saudi Arabia)</td>
<td>ar-SA</td>
<td>German (Luxembourg)</td>
<td>de-LU</td>
<td>Serbian (Latin, Bosnia and Herzegovina)</td>
<td>sr-Latn-BA</td>
</tr>
<tr>
<td>Arabic (Syria)</td>
<td>ar-SY</td>
<td>Greek (Greece)</td>
<td>el-GR</td>
<td>Serbian (Latin, Serbia)</td>
<td>sr-Latn-CS</td>
</tr>
<tr>
<td>Arabic (Tunisia)</td>
<td>ar-TN</td>
<td>Gujarati (India)</td>
<td>gu-IN</td>
<td>Sesotho sa Leboa (South Africa)</td>
<td>na-ZA</td>
</tr>
<tr>
<td>Arabic (U.A.E.)</td>
<td>ar-AE</td>
<td>Hebrew (Israel)</td>
<td>he-IL</td>
<td>Setswana (South Africa)</td>
<td>tn-ZA</td>
</tr>
<tr>
<td>Arabic (Yemen)</td>
<td>ar-YE</td>
<td>Hindi (India)</td>
<td>hi-IN</td>
<td>Slovak (Slovakia)</td>
<td>sk-SK</td>
</tr>
<tr>
<td>Armenian (Armenia)</td>
<td>hy-AM</td>
<td>Hungarian (Hungary)</td>
<td>hu-HU</td>
<td>Slovenian (Slovenia)</td>
<td>sl-SL</td>
</tr>
<tr>
<td>Azeri (Cyrillic, Azerbaijan)</td>
<td>az-Cyrl-AZ</td>
<td>Icelandic (Iceland)</td>
<td>is-IS</td>
<td>Spanish (Argentina)</td>
<td>es-AR</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>Azeri (Latin, Azerbaijan)</td>
<td>az-Latn-AZ</td>
<td>Indonesian (Indonesia)</td>
<td>id-ID</td>
<td>Spanish (Bolivia)</td>
<td>es-BO</td>
</tr>
<tr>
<td>Basque (Basque)</td>
<td>eu-ES</td>
<td>Inuktitut (Latin, Canada)</td>
<td>iu-Latn-CA</td>
<td>Spanish (Chile)</td>
<td>es-CL</td>
</tr>
<tr>
<td>Belarusian (Belarus)</td>
<td>be-BY</td>
<td>Irish (Ireland)</td>
<td>ga-IE</td>
<td>Spanish (Colombia)</td>
<td>es-CO</td>
</tr>
<tr>
<td>Bosnian (Cyrillic, Bosnia and Herzegovina)</td>
<td>bs-Cyril-BA</td>
<td>Italian (Italy)</td>
<td>it-IT</td>
<td>Spanish (Costa Rica)</td>
<td>es-CR</td>
</tr>
<tr>
<td>Bosnian (Latin, Bosnia and Herzegovina)</td>
<td>bs-Latn-BA</td>
<td>Japanese (Japan)</td>
<td>ja-JP</td>
<td>Spanish (Dominican Republic)</td>
<td>es-DO</td>
</tr>
<tr>
<td>Bulgarian (Bulgaria)</td>
<td>bg-BG</td>
<td>Kannada (India)</td>
<td>kn-IN</td>
<td>Spanish (Ecuador)</td>
<td>es-EC</td>
</tr>
<tr>
<td>Catalan (Catalan)</td>
<td>ca-ES</td>
<td>Kazakh (Kazakhstan)</td>
<td>kk-KZ</td>
<td>Spanish (El Salvador)</td>
<td>es-SV</td>
</tr>
<tr>
<td>Chinese (Hong Kong S.A.R.)</td>
<td>zh-HK</td>
<td>Kiswahili (Kenya)</td>
<td>sw-KE</td>
<td>Spanish (Guatemala)</td>
<td>es-GT</td>
</tr>
<tr>
<td>Chinese (Macao S.A.R.)</td>
<td>zh-MO</td>
<td>Konkani (India)</td>
<td>kok-IN</td>
<td>Spanish (Honduras)</td>
<td>es-HN</td>
</tr>
<tr>
<td>Chinese (People's Republic of China)</td>
<td>zh-CN</td>
<td>Kyrgyz (Kyrgyzstan)</td>
<td>ky-KG</td>
<td>Spanish (Mexico)</td>
<td>es-MX</td>
</tr>
<tr>
<td>Chinese (Singapore)</td>
<td>zh-SG</td>
<td>Latvian (Latvia)</td>
<td>lv-LV</td>
<td>Spanish (Nicaragua)</td>
<td>es-NI</td>
</tr>
<tr>
<td>Chinese (Taiwan)</td>
<td>zh-TW</td>
<td>Luxembourgish (Luxembourg)</td>
<td>lb-LU</td>
<td>Spanish (Panama)</td>
<td>es-PA</td>
</tr>
<tr>
<td>Croatian (Bosnia and Herzegovina)</td>
<td>hr-BA</td>
<td>Macedonian (Former Yugoslav Republic of Macedonia)</td>
<td>mk-MK</td>
<td>Spanish (Paraguay)</td>
<td>es-PY</td>
</tr>
<tr>
<td>Croatian (Croatia)</td>
<td>hr-HR</td>
<td>Malay (Brunei Darussalam)</td>
<td>ms-BN</td>
<td>Spanish (Peru)</td>
<td>es-PE</td>
</tr>
<tr>
<td>Czech (Czech Republic)</td>
<td>cs-CZ</td>
<td>Malay (Malaysia)</td>
<td>ms-MY</td>
<td>Spanish (Puerto Rico)</td>
<td>es-PR</td>
</tr>
<tr>
<td>Danish (Denmark)</td>
<td>da-DK</td>
<td>Maltese</td>
<td>mt-MT</td>
<td>Spanish (Spain)</td>
<td>es-ES</td>
</tr>
<tr>
<td>Divehi (Maldives)</td>
<td>dv-MV</td>
<td>Maori</td>
<td>mi-NZ</td>
<td>Spanish (Uruguay)</td>
<td>es-UY</td>
</tr>
<tr>
<td>Dutch (Belgium)</td>
<td>nl-BE</td>
<td>Mapudungun (Chile)</td>
<td>arn-CL</td>
<td>Spanish (Venezuela)</td>
<td>es-VE</td>
</tr>
<tr>
<td>Dutch (Netherlands)</td>
<td>nl-NL</td>
<td>Marathi (India)</td>
<td>mr-IN</td>
<td>Swedish (Finland)</td>
<td>sv-FI</td>
</tr>
<tr>
<td>English (Australia)</td>
<td>en-AU</td>
<td>Mohawk (Mohawk)</td>
<td>moh-CA</td>
<td>Swedish (Sweden)</td>
<td>sv-SE</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>English (Belize)</td>
<td>en-BZ</td>
<td>Mongolian (Cyrillic, Mongolia)</td>
<td>mn-MN</td>
<td>Syriac (Syria)</td>
<td>syr-SY</td>
</tr>
<tr>
<td>English (Canada)</td>
<td>en-CA</td>
<td>Nepali (Nepal)</td>
<td>ne-NP</td>
<td>Tamil (India)</td>
<td>ta-IN</td>
</tr>
<tr>
<td>English (Caribbean)</td>
<td>en-029</td>
<td>Norwegian, Bokmål (Norway)</td>
<td>nb-NO</td>
<td>Tatar (Russia)</td>
<td>tt-RU</td>
</tr>
<tr>
<td>English (Ireland)</td>
<td>en-IE</td>
<td>Norwegian, Nynorsk (Norway)</td>
<td>nn-NO</td>
<td>Telugu (India)</td>
<td>te-IN</td>
</tr>
<tr>
<td>English (Jamaica)</td>
<td>en-JM</td>
<td>Pashto (Afghanistan)</td>
<td>ps-AF</td>
<td>Thai (Thailand)</td>
<td>th-TH</td>
</tr>
<tr>
<td>English (New Zealand)</td>
<td>en-NZ</td>
<td>Persian (Iran)</td>
<td>fa-IR</td>
<td>Turkish (Turkey)</td>
<td>tr-TR</td>
</tr>
<tr>
<td>English (Republic of the Philippines)</td>
<td>en-PH</td>
<td>Polish (Poland)</td>
<td>pl-PL</td>
<td>Ukrainian (Ukraine)</td>
<td>uk-UA</td>
</tr>
<tr>
<td>English (South Africa)</td>
<td>en-ZA</td>
<td>Portuguese (Brazil)</td>
<td>pt-BR</td>
<td>Urdu (Islamic Republic of Pakistan)</td>
<td>ur-PK</td>
</tr>
<tr>
<td>English (Trinidad and Tobago)</td>
<td>en-TT</td>
<td>Portuguese (Portugal)</td>
<td>pt-PT</td>
<td>Uzbek (Cyrillic, Uzbekistan)</td>
<td>uz-Cyrl-UZ</td>
</tr>
<tr>
<td>English (United Kingdom)</td>
<td>en-GB</td>
<td>Punjabi (India)</td>
<td>pa-IN</td>
<td>Uzbek (Latin, Uzbekistan)</td>
<td>uz-Latn-UZ</td>
</tr>
<tr>
<td>English (United States)</td>
<td>en-US</td>
<td>Quechua (Bolivia)</td>
<td>quz-BO</td>
<td>Vietnamese (Vietnam)</td>
<td>vi-VN</td>
</tr>
<tr>
<td>English (Zimbabwe)</td>
<td>en-ZW</td>
<td>Quechua (Ecuador)</td>
<td>quz-EC</td>
<td>Welsh</td>
<td>cy-GB</td>
</tr>
<tr>
<td>Estonian (Estonia)</td>
<td>et-EE</td>
<td>Quechua (Peru)</td>
<td>quz-PE</td>
<td>Xhosa</td>
<td>xh-ZA</td>
</tr>
<tr>
<td>Faroese (Faroe Islands)</td>
<td>fo-FO</td>
<td>Romanian (Romania)</td>
<td>ro-RO</td>
<td>Zulu</td>
<td>zu-ZA</td>
</tr>
<tr>
<td>Filipino (Philippines)</td>
<td>fil-PH</td>
<td>Romansh (Switzerland)</td>
<td>rm-CH</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Glossary

A

annotated study book
A form-by-form summary of the design of a study. Optionally, it includes a time and events schedule, a preview of each form, and selected annotations that list design details.

See also study book (on page 133).

application role
A role associated with administrative activities.

arm
See study arm (on page 133).

authentication
The method of ensuring that you are using the correct user name and password to log on.

authorization
The method of giving users access to information or functionality. Access is controlled using rights, roles, and teams.

B

baseline
A snapshot of all components in a study. Validation creates a baseline.

Baselines Browser
A browser in which you view the results of validation and make temporary baselines public so that other users can work with them.

branch
See study branch (on page 133).

C

calculation rule
A rule that sets the value of an item based on a calculation.

catalog
A collection of categories and keywords that can be attached to users and study objects to facilitate searching in the Libraries Browser and Users Browser.

catalog administration
The process of creating keywords and categories and assigning them to users and study objects for faster and more sophisticated searching.

category
A hierarchical grouping of keywords. You can create categories only from existing keywords.

CDISC
Clinical Data Interchange Standards Consortium. CDISC is an open, multidisciplinary, non-profit organization committed to the development of industry standards to support the electronic acquisition, exchange, submission and archiving of clinical trials data and metadata for medical and biopharmaceutical product development.

checkbox
A type of data entry control in which you can select one or more options by selecting the box that represents each option.

clinical project
See study project (on page 134).
**clinical protocol**
See *protocol* (on page 132).

**clinical study**
See *study* (on page 133).

**codelist**
A collection of code-label pairs that gather together the entry choices for an item. A code-label pair consists of a single code (the value that is used for analysis) and a label (the value that is visible to users).

See also *codelist item* (on page 128).

**codelist item**
A code-label pair consisting of a single code (the value that is used for analysis) and a label (the value that is visible to users). Multiple codelist items make up a codelist.

See also *codelist* (on page 128).

**coding**
The process of selecting terms and codes from a dictionary for a verbatim

**coding dictionary**
A standardized collection of terms and the codes that correspond to those terms.

**coding map**
A study object that contains the necessary information to code an item.

**coding target**
See *target item* (on page 134).

**collaboration**
The process by which users with different roles and specialties can work together to create, validate, and deploy a study.

**collaboration note**
A note that you attach to any study object.

**collaboration note type**
A classification used to identify the type and purpose of a collaboration note.

**Collaboration Notes Browser**
A browser in which you work with collaboration notes.

**common form**
A form that is designed for use with multiple study events. The same data appears in the form in all study events in which the form is used.

**component**
Any design building block that is configured in a study or library. Design components include study objects (such as a project, study, study element, study event, form, or item) as well as rules, individual items selected from drop-down lists, and controls (such as checkboxes and radio buttons).

**compound item**
An item that has one or more child items that can have different data types.

**constant**
A value that is defined in a library or study and that can be referenced by any rule.

**constraint rule**
A rule that checks whether data is valid. Constraint rules are used to confirm that clinical data meets the requirements of the clinical protocol.

**container**
A node in the Project Explorer that contains zero or more study objects or components.

**context item**
An item that provides additional coding information, such as the indication and route of administration for drugs, that can be displayed with an item coded using the WHO-DD dictionary.
CSML
Clinical Study Markup Language. CSML is an XML-based markup language developed by Oracle for representing and exchanging clinical data definitions created in the Central Designer application.

See also MedML (on page 131).

custom data dimension
See data dimension (on page 129).

custom property
A user-defined or default characteristic of a study object.

data dimension
A key item for a data set. A data dimension specifies the additional information that will be saved when study data is collected. You can specify standard data dimensions (Study, Subject, Event and Event Index, Form and Form Index, and Item) and custom data dimensions.

data series
A grouping of one or more items with the same clinical meaning, such as one or more items that measure weight.

See also data set (on page 129), mapping (on page 131).

data set
A grouping of one or more related data series.

See also data series (on page 129), mapping (on page 131).

data type
An attribute for items and data series. For an item, the data type determines the type of entry an item will accept. For a data series, the data type determines which items can be added to it. Data types include date time, integer, float, and text.

data-entry rule
A rule that checks whether data is valid or that sets the value of an item based on a calculation.

See also workflow rule (on page 135).

date time item
An item used to collect date and time information on a form.

deployment
The process of sending a study to a target application. To collect data, a study must be deployed into a target application as a complete deployment package.

dictionary metadata item
An identifier that describes administrative data about a dictionary and that you can use to create a coding map.

dictionary type
A name or identifier for the metadata for a dictionary.

drop-down list
A data entry format in which you select an option from a list.

dynamic form
A form that is automatically generated in the InForm application when subject data satisfies certain criteria tested in another form.

dynamic visit
A visit that is automatically generated in the InForm application when patient data satisfies certain criteria tested in another visit.

eedit check
A data-entry rule that checks whether entered data is valid.

See data-entry rule (on page 129).
**element**
See *study element* (on page 133).

**event**
See *study event* (on page 133).

**explicit lock**
A lock that you request and that does not expire.
See also *implicit lock* (on page 130).

**expression**
The part of a rule that specifies what to evaluate.

**field**
The area in a data-entry window where the value for an item is entered or displayed.

**float item**
An item used to collect numerical values with decimal points.

**form**
A container for one or more items. A form can contain one or more sections and supports multiple locales and layouts. A form is deployed to a target application as a data-entry form used to collect subject information and other clinical data.

**full installation deployment package**
A deployment package that contains everything needed to deploy a complete study.

**function**
A reusable piece of code that extends the behavior of a rule. A function can be predefined or user-defined.

**global condition**
A logical construct that, when applied to a study object, determines whether the study object will appear for a particular subject. A global condition does not affect other study objects in the workflow.
See also *workflow rule* (on page 135).

**globals**
Study objects and properties that are related to mappings.

**grouping**
A default or user-provided value used to organize custom properties of a study object.

**implicit lock**
A type of lock used when you edit a study object. An implicit lock is automatically applied when you select or open a study object and is automatically released when you close or save a study object.
See also *explicit lock* (on page 130).

**incremental deployment package**
A deployment package that contains a complete study based on a previously created deployment package, plus any additions or changes.

**integer item**
An item used to collect a numerical value without a decimal point.

**internationalization**
The process of configuring a study for translation into different languages or for different regional requirements.

**intrinsic rule**
A constraint rule or calculation rule based on a predefined rule template.

**item**
A study object used as a container for the collection of clinical data.
J

Job Log Browser
A browser in which you view the results of asynchronous jobs, such as validation or import.

K

keyword
An identifier that is associated with users and study objects to facilitate more powerful and efficient searches.

L

Libraries Browser
A browser in which you search the repository for study objects and then add them to studies or libraries.

library
A container used to store related study objects and templates to be published for reuse in studies or other libraries. A library provides a view of the study objects in the repository.

See also repository (on page 132).

Library List
A hierarchical list of libraries from which resources can be used. The hierarchy determines the order in which libraries are searched. The Library List is defined for each study in the Study Editor.

library project
A project containing a library.

library role
A role associated with library activities.

library team
A group of users who have rights granted by a certain role to perform tasks in a particular library.

locale
A supported language or language variation.

localization
The process of designing a study for a specific locale.

locked
A state in which only the user who created the lock can modify a study object. Locks can be implicit or explicit.

See also implicit lock (on page 130), explicit lock (on page 130).

M

mapping
A data grouping that provides an alternate data view of a study. Mappings were previously called logical schemas.

See also data series (on page 129), data set (on page 129).

MedML
An XML-based markup language developed by Oracle for representing and exchanging clinical data definitions created in the InForm application.

See also CSML (on page 128).

method
A block of code that is called by a rule and that is used to manipulate data.

N

normalization
The process of converting data to a required format.

O

object
See study object (on page 133).

ODM
Operational Data Model. ODM is an XML-based standard developed by the Clinical Data Interchange Standards Consortium (CDISC) for representing and exchanging clinical data.
P

precondition
The part of a rule that specifies when to evaluate the rule expression.

project
See library project (on page 131) and study project (on page 134).

Project Explorer
A browser that displays a view of the open project and the study objects it contains.

Properties Browser
A browser in which you can view and modify the properties of the study object selected in the Project Explorer.

property
A defining characteristic of a study object.

protocol
A detailed plan that describes how investigators conduct a study. The clinical protocol sets the guidelines for the study, describes the conditions of the study, and contains a set of forms on which clinical data is collected.

publish
The action that makes a study object created in a library available to other users.

See also unpublish (on page 135).

Q

query
A text string that appears on a CRF item in the InForm application when a rule on that item fails. When designing a rule in the Central Designer application, you can specify the query text and the circumstances under which a rule results in a query.

R

radio button
A type of data entry format in which you must select a single item from a list of choices.

reference
A text note, a link to a Web page or file (URL), a document, or a combination of all three, that is attached to a study project for users to consult during the development of a study.

RefName
A unique identifier for a study object.

repeating form
A type of form for which the Repeating property is set to true. You use a repeating form to collect multiple instances of the same data at different dates and times.

repository
A single database instance that contains all Central Designer study objects, components, and users.

revision
An audit history record that is created automatically when a user edits a study object and saves the changes.

right
A predefined permission that controls access to a specific feature or activity in the Central Designer client or Central Designer Administrator client and that can be assigned to one or more roles.

See also role (on page 132).

role
A collection of rights. When a user is assigned to a role, the rights associated with the role are granted to the user.

See also library role (on page 131), study role (on page 134), and user role (on page 127).
role administration
The process of managing tasks that users perform in the Central Designer and Central Designer Administrator applications, assigning rights to roles, and assigning roles to users.

rule
See data-entry rule (on page 129), workflow rule (on page 135).

rule action
The action, or actions, that takes place as a result of the evaluation of a rule expression.

rule scope
The set of study objects that a rule can reference. The scope of a rule is determined by the study object on which the rule is defined.

rule template
A function that is defined on a study object, study object template, or study object type and can be used as the expression clause of a rule.

rule type
See calculation rule (on page 127), constraint rule (on page 128), and intrinsic rule (on page 130).

S
SDTM
Study Data Tabulation Model. SDTM is a CDISC model used to standardize data structures in data extracts.

shared form
See common form (on page 128).

site
A location that participates in a study.

standard data dimension
See data dimension (on page 129).

standard task type
A task type that is typically used for all non-translation tasks assigned to an individual or team.

study
The definition of the workflow, data-entry, and data-management system for a clinical study.

study arm
The CDISC term for a study branch consisting of a planned sequence of study elements. A study arm is typically equivalent to a treatment group.

study book
The set of forms used to collect clinical data. See also annotated study book (on page 127).

study branch
A path for which data is collected for certain subjects. A study can contain multiple branches as different conditions are assessed, and a branch is followed depending on the subject and other circumstances.

study design
A container for the structure of a study.

study element
The CDISC term for a basic building block of a study. A study element represents a segment of a study and can consist of one or more study events. Study elements are optional.

study event
A subject evaluation checkpoint when data is collected. Study events usually correspond to visits, but one visit can span multiple study events.
study object
A study building block that appears in the Project Explorer. Study objects include study projects, library projects, studies, libraries, study elements, study events, forms, sections, items, codelists, and codelist items.
See also component (on page 128).

study object editor
An editor for each study object, such as a project, study, study element, study event, form, or item. A study object editor appears in the workspace when you select a study object.

study project
A project containing one or more studies that are related to each other.

study role
A role associated with study activities.

study team
A group of users who perform tasks granted by a certain role for a particular study.

study workflow
See workflow (on page 135).

subject
An individual who participates in a clinical study.

system
An application to which you deploy a study from the Central Designer application.

system configuration administration
The process of creating, configuring, and managing internationalization, collaboration, and customization information using the Central Designer Administrator application.

t

target item
An item that holds a term, code, or additional information after a verbatim is coded.

task
A request that you attach to a study object and assign to an individual or a study team.

task classification
The classification of a task. You can choose either standard (used for all non-translation tasks assigned to an individual or team) or translation (used for tasks that request translation of a study object into one or more languages). You define the classification for task types in the Central Designer Administrator application.

task type
A classification used to identify the type of the task and the way the task is used.

Tasks Browser
A browser in which you work with tasks.

team
See study team (on page 134), library team (on page 131).

template
A study object that is either partially or fully defined and that can be used to create other study objects. You can create templates for study projects, studies, study elements, study events, forms, items, codelists, and mappings.

text box
A data-entry format in which you type data.

text item
An item used to collect alphanumeric information.
translation task type
A task type that is used for tasks that request translation of a study object into one or more languages.

type
A study object that is either partially or fully defined and can be used to create other study objects. Types are like templates except that types appear as options in the Actions menu and in the Project Explorer menu when you create a new study object.

U
unpublish
The action that makes a study object in a library no longer available to other users.
See also publish (on page 132).

user
A person who works in the Central Designer or Central Designer Administrator application.

user administration
The process of managing users.

Users Browser
A browser in which you search the repository for users and then add them to study teams or library teams.

V
validation
The process of checking the status of a study to indicate if the study is ready for deployment. The study validation process determines whether all essential components exist and are consistent.

verbatim
The original reported text that describes the adverse event, disease, drug, or other item to be coded in the Central Coding application.

verbatim type
A classification of a verbatim as defined in a coding dictionary.

version
An explicitly requested audit history record for a study object.

visit
See study event (on page 133).

W
workflow
The progression of work for a study, as determined by the study designers.

workflow rule
A logical construct that tests data values to determine the study element, study event, or form to which a subject progresses next. A workflow rule prevents study objects in the workflow from appearing until the rule is evaluated.
See also data-entry rule (on page 129), global condition (on page 130).

workspace
The work area of the Central Designer and Central Designer Administrator applications. The contents of the workspace depend on the type of activity you are performing and the rights that you have been granted. The workspace displays the editor for the study object that is selected in the Project Explorer.

Y
yes no item
An item used to collect yes or no answers to questions. A yes no item contains a predefined codelist with Yes and No options.
Index

A
active status • 29
application roles • 103

C
Catalog workspace • 86
catalogs
  Catalog workspace • 86
copying a keyword • 82
  creating and deleting a keyword • 82
  creating and removing a category • 83
cutting, copying, or pasting a category • 84
  searching for a keyword • 81
  workflow for categorizing in • 84
categorization in Central Designer
categorizing a user • 25
  workflow for categorizing users • 84
Categorization tab
  about • 29
  list descriptions • 34
category
  checklist for using • 80
creating and removing • 83
cutting, copying, and pasting • 84
types of categories • 86
  workflow for categorizing • 84
Central Designer applications, about • 2, 3, 4, 6
Change Password dialog box • 35
checklists
  creating and using key • 80
creating users and roles • 18
setting up in Central Designer Administrator for translating text strings • 48
Clintrial application
  Clintrial custom properties • 59
Coding Dictionary Metadata workspace
  about • 73
  option descriptions • 74
coding setup and administration
dictionary metadata • 71, 73
dictionary type • 69, 70, 71
verbatim type • 70, 73
collaboration note in Central Designer
collaboration note type • 52
collaboration note type
  adding, modifying, and deleting • 52
  Note Types workspace • 53, 54
contact information • 22
conversion to different units • 118, 120, 123
Copy User dialog box • 34
Create Role dialog box • 45
Create User dialog box • 34
Custom Properties workspace
  about • 58
  field descriptions • 65
  custom property
    adding, modifying, and removing • 56
  Central Designer application • 64
  Clintrial and InForm custom properties • 59
grouping of • 57

D
dictionary metadata
  Coding Dictionary Metadata workspace • 73, 74
  importing and overwriting • 71
dictionary type in Central Designer
  Dictionary types workspace • 71, 74
  enabling and disabling • 69
  importing and overwriting • 69
  renaming • 70
Dictionary Types workspace
  about • 71
  field descriptions • 74

E
Event Log Messages workspace • 90, 91

F
fluency skill • 24

G
grouping of custom properties
  adding and removing • 57
  moving, cutting, copying, and pasting • 57

H
help, getting • 5, 7

I
inactive status • 29

J
Job Scheduler Manager workspace • 92, 93, 94

K
keyboard shortcuts • 96
  Catalog workspace • 98
  Custom Properties workspace • 97
  opening menus • 96
Roles workspace • 97
Users workspace • 96

keywords
checklist for using • 80
copying • 82
creating and deleting • 82
Searching a catalog for • 81
types • 86
workflow for categorizing • 84

L
library roles • 110
locale
abbreviations for • 124
adding and removing • 48
Supported Locales workspace • 49
locks
object-level locking • 12
logging on and off • 13

N
Note Types workspace
about • 53
field descriptions • 54

O
online Help • 5, 7

P
password
changing • 22
requiring a user to change a password • 22
Personal Info tab
about • 26
field descriptions • 33
properties in Central Designer
custom properties for Clintrial and InForm • 56, 57, 59, 64
Properties tab of the Roles workspace
about • 41
field descriptions • 44

R
redoing • 15
resetting • 14
rights in Central Designer
about • 11, 102
application roles • 103
for default roles • 46
library roles • 110
study roles • 113
viewing rights granted to a user • 22
Rights tab
about • 41
option descriptions • 44
role in Central Designer
about • 11
assigning a user to • 23, 30, 40
assigning rights to • 39
checklist for creating • 18
copying • 39
creating • 38
default roles • 46
deleting • 38
modifying • 39, 40
removing a user from • 23, 40
removing rights from • 40
role scope • 102
Roles workspace
about • 41
refreshing • 38

S
saving • 14
scope, role • 102
security settings • 75
Security workspace
about • 75
option descriptions • 75
server, web farm • 92, 93
Skills tab
about • 28
changing the view of • 24
field descriptions • 34
specifying language fluency skills • 24
sponsor • 51
startup
logging on and off • 13
status bar
option descriptions • 99
study roles • 113
supported locale
list of abbreviations for • 124
Supported Locales workspace • 49
System Config workspace
field descriptions • 49

T
target application • 50
task type • 52
Task Types workspace
about • 53
field descriptions • 54
terminated status • 29
terminology
Central Designer Administrator terms • 6
terms, Central Designer Administrator • 6
toolbar • 99
translation in Central Designer
locales for • 48, 49, 124
setting up in Central Designer Administrator for
translating text strings • 48
text string • 48

U
undoing • 15
unit
about • 118
conversion calculation XML definition • 120
file • 68, 121, 122, 123
Units Definitions workspace • 68
XML definition • 119, 120
Units Definitions workspace • 68
User Info tab
  about • 26
  field descriptions • 32
User Roles tab
  about • 26
  list descriptions • 34
user, Central Designer and Central Designer Administrator
  about • 11
  activating, deactivating, terminating • 20
  categorizing • 25
  Central Designer Administrator users • 3
  Central Designer users • 4
  changing • 21, 22
  copying • 20
  creating • 18, 20
  default users • 31
  finding • 21
  passwords • 22
  removing • 23, 40
  role assignment • 23, 30, 40
  specifying language fluency skills • 24
  statuses of users • 29
  viewing rights • 22
Users list • 21
Users tab
  about • 43
  list descriptions • 45
Users view • 32
Users workspace
  about • 26
  refreshing • 21

V
verbatim in Central Designer
  type • 70, 73
Verbatim Types workspace • 73
views
  about • 10

W
wb farm
  Event Log messages and • 90, 91
  primary job scheduler for • 92, 93, 94
  servers in • 92, 93
workspace
  about • 10
  Custom Properties workspace • 58
  in the Central Designer Administrator application • 10
  Note Types workspace • 53
  Roles workspace • 41
  Supported Locales workspace • 49
  Task types workspace • 53
  Users workspace • 26